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Contenu de ce guide

Ce guide d'utilisation contient des instructions de mise en
route, d'utilisation, de dépannage et de maintenance du systeme
de scanner de puces a ADN Agilent.

Introduction

Ce chapitre décrit le scanner de puces a ADN et la préparation
de son utilisation.

Mise en route

Ce chapitre décrit I'utilisation du scanner de puces a ADN ;
il explique notamment comment configurer l'appareil et
numériser des diapositives a l'aide du programme Scan Control.

Modification des parameétres de numérisation

Ce chapitre décrit les parametres de numérisation, puis
explique dans quelles circonstances et par quelles méthodes les
modifier.

Utilisation des outils

Ce chapitre explique comment configurer des profils (groupes
de parameétres de numérisation), définir des régions de balayage
et programmer l'activation et la désactivation automatiques des
lasers.

Maintenance et dépannage du systéeme

Ce chapitre décrit les procédures de maintenance, fournit un
certain nombre de conseils et explique les messages d'erreur
permettant de dépanner le systeme.

Références

Ce chapitre présente les spécifications en matiére de
diapositives et fournit des informations sur la conformité a la
réglementation.
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Ce chapitre fournit une présentation générale

du systéme de scanner de puces a ADN Agilent G2565CA.

Cette section décrit les caractéristiques qui font du scanner de
puces a ADN un excellent outil pour la solution d'analyse de

puces a ADN Agilent.

Cette section traite des fonctions matérielles et logicielles du
scanner de puces a ADN, des éléments du systeme, de la
configuration requise, de la préparation du site et des consignes

de sécurité.

Cette section décrit le fonctionnement du scanner de puces

a ADN.
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1 Introduction

Un excellent outil d'analyse de puces a ADN

Le scanner de puces a ADN Agilent G2565CA est 1'un des
composants de la solution d'analyse de puces a ADN d'Agilent
Technologies. Ce scanner de fluorescence induite par laser
perfectionné est concu pour lire des puces a ADN imprimées
sur des diapositives standard de 25,4 x 76,2 mm (1" x 3").

Le scanner de puces a ADN mesure l'intensité de fluorescence
d'échantillons d'acides nucléiques (ADN et ARN) marqués, liés a
des puces a ADN. Il peut mesurer simultanément la
fluorescence de deux colorants, ce qui facilite toutes les études
de puces a ADN en deux couleurs. Cette technologie permet une
analyse automatique de puces a ADN rapide et de haute qualité.

Figure 1 Scanner de puces a ADN Agilent G2565CA

Chaque diapositive est numérisée en quelques minutes, puis les
fichiers sont préparés pour l'analyse par extraction de motifs.
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Description du systeme

Introduction 1

Cette section énumere les fonctions matérielles et logicielles du
systeme, dresse la liste des piéces, définit la configuration
informatique requise, décrit le scanner et fournit des
informations sur la préparation du site et la sécurité.

Fonctions materielles et logicielles

Le scanner de puces a ADN posséde les fonctions suivantes :

Lecture de codes-barres internes et externes

Autofocus dynamique

Etalonnage automatique du gain du PMT avant chaque analyse
Stabilisation continue de la puissance du laser

Tailles de pixel : 2, 3, 5 ou 10 microns

Plage dynamique > 104 pour un seul balayage en mode
16 bits, > 10° pour un seul balayage en mode 20 bits et > 108
pour un double balayage en mode 16 bits (XDR).

Compression de fichiers d'image TIFF

Spécification d'uniformité < 5 % CV (coefficient de variation)

Le logiciel Scan Control permet de sélectionner les voies de
colorant (fluorescence), les régions a balayer, la résolution, la
plage dynamique, le gain du PMT et le dossier de sortie pour
chacune des diapositives de la série. Il est possible de charger
automatiquement ces parametres a partir de profils
d'application enregistrés ou de les sélectionner un par un.

Nomenclature des piéces

Le systeme de scanner de puces a ADN Agilent G2565CA
comprend les éléments suivants :

Scanner de puces a ADN

Panier avec 50 porte-diapositives

PC avec logiciel de restauration sur CD
Cables d'alimentation et cable USB
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Introduction

¢ Logiciel Scan Control 8.4
¢ Logiciel Feature Extraction 10.x

¢ Certificat de conformité

Le logiciel Agilent Scan Control 8.4 est destiné au logiciel
Agilent Feature Extraction (FE) 9.5 et aux versions ultérieures.
Les numérisations 16 bits avec pixels de 5 ou 10 microns sont
compatibles avec FE 9.5. Les numérisations avec pixels de 2 ou
3 microns, ainsi que toutes les numérisations 20 bits,
nécessitent FE 10.x.

Configuration informatique requise

Avant d'installer et d'utiliser le logiciel Agilent Scan Control,
assurez-vous que votre systéeme présente les caractéristiques
suivantes :

Logiciels
¢ Windows XP Professionnel avec SP2 ou Windows Vista
32 bits avec SP1

¢ Internet Explorer 5.5 ou version ultérieure

Matériel

¢ Pentium IV a 3,2 GHz ou supérieur

* 2 Go de RAM (4 Go de RAM si le logiciel Feature Extraction
est installé sur le méme PC)

e 250 Go d'espace disque pour les programmes et la création
de données
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Introduction 1

Description matérielle du scanner

Vue de face du scanner

Ouverture et capot
Capot du filtre a air

Témoins
d'état

— e

Interrupteur
de mise /_____———-@
sous tension |

Figure 2 Vue de face du scanner de puces a ADN

Vue de dessus du scanner

Bras de chargement automatique

Capot de porte-diapositives

Etiquette
informative

Base du
panier a
diapositives

Figure 3 Vue de dessus du scanner de puces a ADN
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1 Introduction

Vue arriére du scanner

Quie d'aération

————, Porte-fusible

L Indicateur
de tension d'alimentation

/ Réglage de tension
d'alimentation

\5\

N
H) .
N/ \ //\:,o(;.le de prise
7 \ alimentation
Connexion USB

Porte-fusible du laser

Figure 4 Vue arriére du scanner de puces a ADN

Préparation du site

Assurez-vous que le site respecte
les “Spécifications du scanner de
puces a ADN”, page 96, au
chapitre 6. Pour toute question,
contactez le représentant local du
service clientéle Agilent ou
rendez-vous sur le site
www.agilent.com/chem/dnasupp
ort.

Assurez-vous
de disposer
d'un
dégagement
suffisant au-
dessus du
capot.

Placez le systéme = _*_ h
sur une table o
ou un établi. \. — é
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Introduction 1

Pictogrammes de sécuriteé utilisés sur le scanner

2 Pictogramme ATTENTION
.  Ce pictogramme ATTENTION est placé sur le produit partout ot

vous devez consulter le guide produit pour comprendre un
danger potentiel. Si la manceuvre ou la procédure
correspondante n'est pas exécutée correctement, il peut y avoir
un risque d'endommagement de l'appareil ou de perte de
données importantes.

f : Pictogramme AVERTISSEMENT
4 Ce pictogramme AVERTISSEMENT est placé sur le produit,

dans la zone ol une tension dangereuse est présente et ol une
électrocution peut survenir. Seuls des techniciens de
maintenance qualifiés doivent étre autorisés a intervenir dans
cette zone.
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1 Introduction

Consignes de sécurité

De par sa conception, le scanner de puces a ADN Agilent
G2565CA permet une utilisation facile et siire. Avant d'utiliser
le scanner de puces a ADN, assurez-vous d'avoir bien compris et
de respecter toutes les précautions désignées par les mentions
AVERTISSEMENT et ATTENTION.

PTTIIITaE N'essayez pas d'accéder aux composants internes du scanner de
puces a ADN ni de réparer ces composants. Vous risqueriez de vous
exposer a des hautes tensions ou a des rayonnements laser nocifs.
L'ouverture du boitier annule la garantie.

P L TII'IE  Lescannerde puces a ADN doit étre branché sur une prise de
courant mise a la terre. Sa sécurisation nécessite une terre de
protection.

Avant la premiére mise sous tension du scanner de puces a ADN ou
aprés le déplacement de I'appareil, assurez-vous que le réglage de
tension est correct et que la tension est mise a la terre.

Agilent recommande de placer le scanner de puces a ADN sur une
table ou un établi solide. Le scanner de puces a ADN peut émettre des
vibrations et se révéler sensible aux vibrations externes.

Le scanner de puces a ADN peut se révéler sensible a I'humidite,
lorsqu'elle atteint le point de saturation. Respectez les prescriptions de
la documentation produit. Référez-vous a la section “Prévention des
problémes”, page 71, au chapitre 5, et aux conditions d"humidité
relative, page 96, au chapitre 6.

16 Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Introduction 1

Principes de fonctionnement

Cette section décrit les caractéristiques de fonctionnement du
scanner de puces a ADN Agilent G2565CA.

Positionnement des diapositives

Le scanner de puces a ADN peut accueillir 48 diapositives de
25,4 x 76,2 mm (1" x 3") dans un panier amovible. Lors d'une
série de numérisations, les diapositives sont mises en position
de numérisation, numérisées, puis replacées dans le panier,
les unes apres les autres.

Excitation par laser

Le scanner de puces a ADN utilise deux lasers : un laser YAG a
doublage de fréquence (532 nm) et un laser a hélium-néon
(633 nm). Ces lasers excitent de ' ADN ou de 'ARN marqué a la
cyanine 3 (Cy-3) et a la cyanine 5 (Cy-5) afin de mesurer la
fluorescence aprés hybridation entre l'acide nucléique cible et
les sondes de la puce a ADN. Il est également possible d'utiliser
des colorants similaires a la Cy-3 et & la Cy-5 (par exemple,
colorants Alexa 647, 655 et 660).

Le scanner de puces a ADN est optimisé pour fournir un haut
rapport signal/bruit dans les bandes d'émission de la Cy-3
(650 2 610 nm) et de 1la Cy-5 (650 a 750 nm) avec une grande
plage dynamique (jusqu'a 105) et une faible intermodulation
spectrale. Ces caractéristiques permettent une tres large plage
de concentrations cibles et une plus grande fiabilité des
données aux niveaux de signal faibles.

Balayage

Le laser balaie rapidement la puce a ADN dans les deux sens.
La fonction d'autofocus dynamique garantit le placement
systématique de la puce dans le plan focal de la lentille du laser,
donc I'uniformité du balayage.
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Détection de fluorescence

Un PMT hautes performances convertit la fluorescence des
échantillons marqués en signal électrique. Des intégrateurs
numériques et des amplificateurs a bruit trés faible
transforment le signal du PMT en une mesure numérique qui est
alors enregistrée dans le fichier TIFF.

Soustraction de I'offset

Lorsque les signaux sont tres faibles, le bruit peut rendre les
valeurs de pixel négatives. Plutot que de régler ces valeurs sur
zéro, ce qui donne une mesure biaisée, le scanner Agilent ajoute
un léger décalage a toutes les valeurs de pixel : ainsi, toute la
distribution de pixels est prise en compte. Ce décalage constant
n'est pas du bruit ; le logiciel Agilent Feature Extraction le
supprime de maniere statistiquement correcte.
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2 Mise en route

Licences

Le scanner Agilent se décline en deux configurations (a choisir
a la commande) :

configuration haute résolution standard,

configuration sans fonction haute résolution.

Sans licence haute résolution, vous pouvez sélectionner les
modes 10 microns, 5 microns et 5 microns avec double balayage,
mais les modes 2 microns et 3 microns sont indisponibles.

Si vous avez acheté la fonction haute résolution, vous avez
besoin d'une licence logicielle pour l'activer. En regle générale,
le technicien chargé d'installer le scanner installe également la
licence. Si ce n'est pas le cas, ou si vous achetez cette fonction
apres coup, suivez les instructions ci-dessous pour échanger la
licence logicielle.

Echange de la licence de numérisation haute résolution

Pour échanger une licence de numérisation haute résolution,
procédez comme suit :

1 Recherchez le certificat de droits logiciels (software
entitlement certificate, SEC) livré avec le scanner.

2 Rendez-vous a l'adresse
https://software.business.agilent.com/index.stm.

3 Sélectionnez Click here to start software license redemption
(Cliquez ici pour démarrer 1'échange de licence logicielle).

4 Suivez les instructions pour échanger la licence.

Installation de la licence de numérisation haute résolution

Apres réception de I'e-mail contenant la licence, installez cette
derniere comme suit :

1 Fermez la fenétre du logiciel Scan Control.

2 Recherchez le fichier de licence et placez-le dans le
répertoire suivant :

C:\ProgramFiles\Agilent\Microarray
3 Rouvrez le logiciel Scan Control.
Les modes 2 et 3 microns sont désormais disponibles.
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Mise en route 2

Licence pour codes-barres tiers

Si vous avez besoin de numériser des codes-barres tiers avec
une résolution de 2 ou 3 microns, contactez Agilent et
demandez une licence gratuite pour la fonction correspondante.

Sans cette licence, si vous essayez de numériser une diapositive
qui ne comporte pas de code-barres ou n'est pas reconnue par le
scanner comme une puce Agilent avec une résolution de 2 ou 3
microns, le scanner ne traitera pas cette diapositive ; le message
suivant apparaitra :

Scan settings or slide is not supported by the current scanner
license. Contact Agilent via pdl-non_ag_barcode@agilent.com to
obtain license to scan non-Agilent barcodes in
high-resolution.(Diapositive ou parameétres de numérisation non pris
en charge par la licence actuelle du scanner. Contactez Agilent a
I'adresse pdl-non_ag_barcode@agilent.com afin d'obtenir une
licence de numérisation haute résolution pour codes-barres tiers.)

Obtention et installation d'une licence pour codes-barres tiers

1 Envoyez un e-mail & 1'adresse PDL-non_ag_barcode@agilent.com
en indiquant le numéro de série du scanner dans le corps du
message. Une licence vous sera adressée dans un bref délai.
Vous devrez renouveler cette licence tous les ans.

2 Lorsque vous recevez la licence, placez-la dans le répertoire
suivant :

C:\ProgramFiles\Agilent\Microarray
3 Fermez et rouvrez le logiciel Scan Control.

Le scanner reconnaitra la nouvelle licence.
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2 Mise en route

Utilisation du scanner

Etape 1: mise sous tension du scanner de puces a ADN Agilent

4 Mettez le scanner de puces a ADN sous tension au moyen de
l'interrupteur situé a l'avant de l'appareil. Vous observerez
trois changements :

a Un ventilateur se met en marche et le capot se verrouille.

b Le scanner de puces a ADN entame une procédure
d'initialisation qui dure environ quatre minutes. Lors de
l'initialisation, un autotest est réalisé ; durant ce test, les
témoins d'état s'allument et s'éteignent au fur et a mesure
des différents controles fonctionnels.

¢ Les lasers ne sont mis sous tension qu'au démarrage du
logiciel Scan Control.

Témoins
d'état
B e~ ———
\ Ty 2 o
Hf trngn. STTTETES :;{:%:
Interrupteur >
de mise sous ==
tension |

Figure b Emplacement de I'interrupteur de mise sous tension et des
témoins d'état

Pour savoir comment configurer 5 Double-cliquez sur l'icone Agilent Scan Control pour ouvrir
I'appareil de telle maniére que les le programme Scan Control.
lasers se mettent en marche et Ou

s'arrétent automatiquement,
référez-vous a la section
"Configuration de I'activation et de
la désactivation des lasers”,

page 63, au chapitre 4.

Cliquez sur Démarrer > Tous les programmes > Agilent >
Scan Control.

Figure 6 Icone Agilent Scan Control
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Initializing Scanner
(Initialisation du
scanner)

Lasers are warming up
(Préchauffage des
lasers)

Lasers are powered off
(Lasers hors tension)

Scanner ready
(Scanner prét)

E2a Agilent Scan Control
File Tools Help

Statshot: [1 Endsit [10 —

4

Mise en route 2

Lorsque le programme démarre, le préchauffage des lasers commence.

Consultez le message Scanner status (Etat du scanner) en
bas de la fenétre principale.

Le scanner est en cours d'initialisation. A la fin de
l'initialisation, le capot du scanner se déverrouille, tandis que
les lasers continuent & chauffer.

Le préchauffage des lasers dure environ 30 minutes. Pendant que
les lasers montent en température, passez a la section "Etape 2 :
insertion des diapositives dans les porte-diapositives", page 24.

Pour mettre les lasers sous tension, cliquez sur Tools > Laser Auto
ON/OFF Settings... (Outils > Parameétres d'activation/de
désactivation auto. des lasers), puis sur Turn Lasers ON Now

(Activer les lasers maintenant).

Vous pouvez démarrer la numeérisation.

Frofle:  |EETERENE

Slot Slide 1D Channels | Scan Region Fiesalution

1| chutodetsct: P Agilent HD (61 421 Bmm] 5um
2| <Autodetect R Agilent HD (61 %21 Bom) 5 um
3 | <Autodetectr  R+G Agilert HD (61 % 21.6mm)  Sum
4 | <Autodetectr  R+G Agilent HD [E1 » 21.Bmm] B um
5 | cAuodetects  ReG Agilent HD [ %21 ] 5 um
6 | <Autodetect R Aailent HD (1 % 21 Brom) 5 um
7 | <Autodetectr  R+G Agilert HD (61 % 21.6mm)  Sum
8 | <Autodetectr R+G Agilent HD [E1 % 21.6mm)  Sum
o | <Auto detect>  A+G Agilent HD 61 & 21.6mim] 5 um
10| chutodetects R Aailent HD (61 % 21 Brom) 5 um

TIFF

20 bit
20 bit
20 bit
20 bit
20 hit
20 bit
20 bit
20 bit
20 bit
20 bit

RPMT | GPMT | XDR

100%
100
100%
100%
1002
100
100%
100%
100%
100

100%
100
100%
100%
1002
100
100%
100%
100%
100

<No XDR>
<No XDR>»
<No XDR>
<No *DR>
<MoXDR>
<No ¥DR>
<No DR
<No XDR>
<No *DR>
<NoXDR>

Output Path
D:\ScanData
D:\ScanData
D:\ScanData
D:\SeanData
D:hSeanData
D:\ScanD ata
D:\ScanData
D:AScanData
D:\ScanData
D:\SeanD ata

Pour le démarrage d'une série de numérisations, le
préchauffage des deux lasers doit étre terminé.

DOperator

Desciiption

| i

Scanner ready

Compress: [Off] Split/Rotate: [OFf]

Naming: 1US1470PPB1_<Slde ID:>_S<Scan 43

Tokal file size: 3.0 GB

ScanSlat1-10

Tokal run time: 1 hr 20 min

Figure 7

Fenétre principale de Scan Control lorsque les lasers sont préts
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Etape 2 : insertion des diapositives dans les
porte-diapositives
Avant de charger une diapositive dans le panier, vous devez

l'insérer dans un porte-diapositive qui la protégera pendant
la numérisation.

Figure 8 Chargement des diapositives dans les porte-diapositives

Les traces de doigt peuvent 1 Tenez le porte-diapositive par les bords, logo Agilent vers
provoquer des erreurs lors de la le haut.
détection de fluorescence. Dans un

but d'exactitude des mesures, .
tenez les diapositives par les bords 3 Appuyez doucement sur le couvercle, puis poussez-le vers

et portez toujours des gants le haut du porte-diapositive jusqu'a ce qu'il s'ouvre.

Posez le pouce au milieu du couvercle du porte-diapositive.

lorsque vous les manipulez.

N'écrivez jamais sur les Pour savoir comment retirer les diapositives, référez-vous a la
diapositives et n'y placez aucune section "Etape 5 : retrait des diapositives", page 33.

étiquette, exception faite d'un

code-barres conforme aux

prescriptions.

24 Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Mise en route 2

Couvercle de
porte-diapositive
ouvert

Figure 9 Ouverture du couvercle

4 Placez la diapositive dans le porte-diapositive en appuyant
l'extrémité de la diapositive contre le rebord arriére.

La surface active de la puce a ADN doit étre dirigée vers le haut.

Surface active de la
puce a ADN

Rebord du
porte-diapositive

Figure 10  Diapositive bien placée contre le rebord
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5 Alignez la diapositive avec le porte-diapositive, en respectant
les deux régles suivantes :

L'extrémité opposée au code-barres doit étre appuyée
contre le rebord arriere.

La face de la diapositive sur laquelle est fixée la puce doit
étre placée face au couvercle. La puce est numérisée a
travers le verre.

Assurez-vous de suivre ces régles chaque fois que vous
alignez une diapositive.

Les diapositives Agilent comportent deux codes-barres, un
sur chaque face (voir la Figure 11). Les diapositives tierces
n'en possedent habituellement qu'un. Dirigez toujours la face
portant la puce vers le couvercle du porte-diapositive.

Si vous souhaitez poser un Si le code-barres se trouve sur la face opposée a celle des
deuxiéme code-barres lisible, spots, le scanner ne peut pas lire le code-barres.
référez-vous a la section

"Spécifications de codes-barres et

d'étiquettes de code-barres”,

page 99.

Les diapositives mal insérées peuvent endommager le scanner de
puces a ADN.

26 Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Mise en route 2

Double-barcoded slide example

=
Y
Sm
El .
SIDE1 5= Inactive Glass Surface
=1
S -
sa
-
=
i . .
Z = Active Active
SIDE2 §= Microarray Microarray
2= Surface Surface
]
-

Figure 11  Orientation des diapositives

6 Lachez l'extrémité libre de la diapositive pour qu'elle entre
dans le porte-diapositive.

La diapositive doit étre 1égerement courbée entre les taquets
latéraux du porte-diapositive.

Figure 12  Pose de la diapositive dans le porte-diapositive

7 Pour fermer le couvercle du porte-diapositive, appuyez
doucement dessus avec le pouce.
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Figure 13  Fermeture du couvercle

8 Pour bloquer le couvercle, repoussez-le délicatement avec le
pouce jusqu'a la butée.

Figure 14  Blocage du couvercle

9 Vérifiez que le couvercle du porte-diapositive est entierement
bloqué.

Couvercle bloqué sous
les taquets latéraux

Figure 15 Couvercle correctement bloqué
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Etape 3 : chargement des porte-diapositives dans le panier

Le scanner de puces a ADN
numeérise les diapositives dans
'ordre de leur détection pendant
que le panier tourne des numéros
d'emplacement les plus bas vers
les plus hauts. Les éventuels
emplacements vides

sont ignorés.

Une fois les diapositives insérées dans les porte-diapositives,
vous pouvez les placer dans le panier. Celui-ci est con¢u pour
que l'on puisse facilement y charger correctement un
porte-diapositive. Il est possible de charger les
porte-diapositives dans le panier, que celui-ci soit ou non placé
dans le scanner.

1 Placez un porte-diapositive dans l'emplacement 1 du panier
(premier emplacement apres la position de repos, en
tournant dans le sens des aiguilles d'une montre).

Ne placez pas de diapositive dans I'emplacement de départ
du panier. Cet emplacement est plus large que les autres et
désigné par la mention "Home".

2 Vérifiez que le coté étroit du porte-diapositive est dirigé vers
le centre du panier.

3 Assurez-vous que le porte-diapositive repose bien au fond de
l'emplacement dans le panier.

Cote étroit
dirigé vers le
centre

Emplace-
ment

Figure 16  Panier

Un mauvais positionnement du porte-diapositive dans le panier peut
endommager gravement le scanner de puces a ADN.
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4 Si le panier est déja en place, passez a I'étape 5.
Si ce n'est pas le cas, remettez le panier en place.
Si vous avez placé les porte-diapositives dans le panier hors

du scanner de puces a ADN, remettez le panier en place
comme suit :

a Posez le panier de telle maniére que les broches d'alignement
de la zone du panier, sur le scanneur de puces a ADN, entrent
dans les orifices correspondants, sur le panier.

Alignez le trou en D, au fond du panier, avec la tige en D du
plateau du scanner (emplacement du panier), puis
poussez doucement le panier vers le bas pour le placer
dans le scanner.

b Vérifiez que le panier est bien en place.
Lors de l'installation du panier, veillez a ne pas heurter le bras de

chargement automatique : cela peut fausser I'alignement.

Si vous devez tourner manuellement le panier, mettez d'abord le scanner
hors tension ; autrement, vous risqueriez d'endommager I'appareil.

5 (Facultatif) Placez le couvercle sur le panier en appuyant
jusqu'a ce que les deux taquets latéraux se mettent en place.

Emplacement

Figure 17  Couvercle du panier
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6 Fermez le capot du scanner.

Lorsque le capot est ouvert, les taches suivantes sont
impossibles :

Initialisation du scanner
Recherche d'emplacements vides dans le panier

Lecture des codes-barres, préalable a la série de
numérisations

Lancement de la série de numérisations

Broches d'alignement fixes Orifices pour broche

Broche d'alignement amovible Orifice pour broche d'alignement

Figure 18  Broches d'alignement et orifices correspondants sur le
scanner et le panier

Si un message d'erreur signalant un dépassement de délai
moteur apparait dans le journal Rapport de numérisation en
série (Carousel Report Log), cela indique peut-étre que le panier
est mal monté. Controlez l'alignement du panier et réinstallez ce
dernier, si nécessaire.

Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4) 31



2 Mise en route

Etape 4 : numérisation des diapositives

On appelle "numérisation" I'opération
consistant a créer une image des
sondes d'une diapositive. Une "série
de numérisations" comprend les
numeérisations de toutes les
diapositives indiquées placées dans le
panier.

Pour préparer les diapositives en vue de leur numérisation et
lancer la série de numérisations, suivez les étapes ci-dessous.
Pour plus de détails, référez-vous a la section "Numérisation de
diapositives", ci-apres.

"Etape 1 : choix des emplacements a numériser", page 36

"Etape 2 : définition d'un profil permettant de modifier
I'ensemble des parametres du tableau de numérisation", page 37

"Etape 3 : modification de parameétres de numérisation pris
isolément dans le tableau de numérisation", page 38

"Etape 4 : lancement de la série de numérisations", page 39

"Etape 5 : transfert des fichiers et archivage des données",
page 42
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Etape 5 : retrait des diapositives

A l'issue de la série de numérisations, vous pouvez décharger les
porte-diapositives du panier, puis sortir les diapositives des
porte-diapositives.

1 (Facultatif) Retirez le panier du scanner.

Si le bras de chargement automatique des porte-diapositives
est en position dépliée, laissez le panier en place. Suivez les
instructions de la section "Dépannage du bras de chargement
automatique lorsqu'il reste déplié dans le panier", page 82.

Retirez les porte-diapositives du panier.
Retirez les diapositives des porte-diapositives.

a Tenez le porte-diapositive par les bords, logo Agilent vers
le haut.

b Posez le pouce au milieu du couvercle du
porte-diapositive.

¢ Appuyez doucement sur le couvercle, puis poussez-le vers
le haut du porte-diapositive jusqu'a ce qu'il s'ouvre.

Couvercle de
porte-diapositive
ouvert
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d Prenez le porte-diapositive par le bas, puis poussez le c6té
code-barres de la diapositive vers le haut pour éviter de
laisser des traces de doigts dans la zone de 1'échantillon.

e Prenez la diapositive par les bords et sortez-la du
porte-diapositive.

Poussez vers le haut

Figure 19  Bonne méthode de retrait de la diapositive
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Etape 6 : réglage de la désactivation automatique des lasers

Vous pouvez prolonger la durée de vie des lasers en réglant
l'appareil de telle maniere qu'il les désactive a certains
moments. Pour en savoir plus, référez-vous a la section
"Configuration de l'activation et de la désactivation des lasers",
page 63, au chapitre 4, "Utilisation des outils".

Il est inutile de mettre le scanner de puces a ADN hors tension.

Si vous souhaitez néanmoins le faire, procédez comme suit :

1 Dans la fenétre principale du logiciel Scan Control, cliquez
sur Exit (Quitter).

Pour éviter un blocage intermittent de la communication,
fermez le logiciel Scan Control avant de mettre le scanner de
puces a ADN hors tension.

2 Attendez quelques secondes, puis vérifiez que le capot du
scanner de puces a ADN est déverrouillé.

3 Relevez le capot.

4 Mettez le scanner de puces a ADN hors tension au moyen de
l'interrupteur situé a 'avant de 'appareil.

Pour relever le capot, attendez de I'avoir entendu se déverrouiller. Si
vous essayez de relever le capot pendant que le scanner de puces a
ADN le déverrouille, vous risquez de provoquer un blocage.
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Numeérisation de diapositives

Etape 1: choix des emplacements a numeériser

Si vous numérisez les diapositives placées dans les 48
emplacements, passez a 1"Etape 2 : définition d'un profil
permettant de modifier 'ensemble des parametres du tableau
de numérisation", page 37.

1 Dans la zone Start slot (Premier emplacement), sélectionnez
le numéro de I'emplacement qui contient la premiere
diapositive & numériser.

2 Dans la zone End slot (Dernier emplacement), sélectionnez le
numéro de I'emplacement qui contient la derniére diapositive
a numériser.

Start slot:: v End slot: |43 =

La plage d'emplacements définie aux points 1 et 2 influe sur la
plupart des fonctions de la fenétre principale de Scan Control.

¢ Seuls les emplacements sélectionnés apparaissent dans le
tableau de numérisation.

¢ Le scanner numérise uniquement les diapositives de cette
plage d'emplacements.

¢ La commande Carousel Check (Controle du panier)
recherche les emplacements vides et les codes-barres pris en
charge par Agilent dans cette plage, a I'exclusion de tout
autre emplacement (voir la section "Recherche de
codes-barres pris en charge par Agilent et d'emplacements
vides", page 49 au chapitre 3).
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Etape 2 : définition d'un profil permettant de modifier
I'ensemble des parametres du tableau de numeérisation

On appelle "profil" un ensemble de
parametres d'image et de numérisation
qui, lorsqu'on le sélectionne, remplit le

tableau de numérisation avec les
valeurs saisies dans |'outil Profile
Editor (éditeur de profils).

<default>
AgilentHD_GX_2Color
AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD_miRNA
AgilentG3_CGH

¢ Dans la liste Profile (Profil), sélectionnez I'un des profils
existants.

Frofile:

A T'ouverture de la fenétre principale de Scan Control, les
colonnes contiennent des valeurs de parametres de
numérisation. Ces valeurs proviennent du dernier profil
sélectionné avant la fermeture du programme.

Agilent fournit six profils préchargés, a utiliser avec les puces a
ADN haute densité Agilent, les puces a ADN G3 Agilent et les
puces a ADN tierces.

Parametres par défaut actifs apres l'installation du programme
Puces d'expression de genes a 2 couleurs haute densité Agilent
Puces d'expression de genes a 1 couleur haute densité Agilent
Puces CGH/CNV/ChIP haute densité Agilent

Puces miRNA haute densité Agilent

Puces CGH/CNV/ChIP G3 Agilent

Pour changer tous les parametres a la fois, vous pouvez
sélectionner un profil Agilent ou en créer un vous-méme a
partir de n'importe quel profil existant, y compris le profil
<Default> (profil par défaut).

Pour modifier un profil ou en créer un vous-méme, référez-vous
a la section "Modification d'un profil existant", page 55 ou a la
section "Création d'un profil", page 56, au chapitre 4.
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Etape 3 : modification de paramétres de numérisation pris
isolement dans le tableau de numérisation

Si les parametres du tableau de numérisation engendré par le
profil sélectionné vous conviennent, attendez que le message
Scanner ready (Scanner prét) s'affiche dans la zone Scanner
status (Etat du scanner), puis passez a I""Etape 4 : lancement de
la série de numérisations", page 39.

1 Sélectionnez les cellules contenant les valeurs a modifier, par
I'une des méthodes suivantes :

Cliquez sur une cellule.
Cliquez sur un en-téte de colonne.

Pour sélectionner plusieurs cellules adjacentes dans une
méme colonne, faites glisser le curseur de haut en bas sur
les cellules a sélectionner. Une fleche apparait a
l'extrémité droite de la premieére cellule sélectionnée.

Pour sélectionner des cellules non adjacentes dans une
méme colonne, maintenez la touche Ctrl enfoncée et
cliquez sur chacune des cellules. Une fleche apparait a
l'extrémité droite de la derniére cellule sélectionnée.

2 Sélectionnez un nouveau parametre dans la liste.
Le nouveau parameétre s'affiche en gras.

Scan Region F

Agilent HD [B Brrn] i e}
Full Slide [71 = 21.6mm)
Agilent HD [61 = 21.6mm

A AU G X 2.0 3

La taille de fichier et la durée d'exécution estimées s'affichent dans la
ligne d'état, en bas de la fenétre principale de Scan Control. Les fichiers
temporaires créés pendant la numérisation occuperont de I'espace sur le
disque C:. Sila taille totale estimée des fichiers d'image et des fichiers
temporaires est supérieure a I'espace disque disponible, le scanner
empéche le démarrage de la série de numérisations.

Agilent recommande de sélectionner un chemin de sortie (Output Path)
pour enregistrer les fichiers sur un disque local. Si vous sélectionnez un
lecteur réseau comme chemin de sortie et que la connexion réseau est
interrompue, les fichiers sont stockés sur le lecteur C: local, dans le
répertoire Program Files\Agilent\Microarray\NetDataBackup.
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Etape 4 : lancement de la série de numérisations

Une série de numérisations numérise toutes les diapositives
sélectionnées du panier.

1 Assurez-vous que le message Scanner ready (Scanner prét)
s'affiche dans la zone Scanner status (Etat du scanner) de la
fenétre principale.

Pour que la série de numérisations puisse commencer, le
préchauffage des lasers doit étre terminé.

2 Dans la fenétre principale de Scan Control, cliquez sur le
bouton Scan Slot m-n (Emplacement de numérisation m-n).

La lettre m représente le numéro de I'emplacement
contenant la premiére diapositive et la lettre n représente le
numéro de I'emplacement contenant la derniére diapositive.

Lorsque vous déclenchez la numérisation, deux changements
surviennent :

Le capot du scanner se verrouille.

La boite de dialogue Scan Progress (Avancement de la
numérisation) s'ouvre. Elle indique I'état d'avancement
de la numérisation.

Scan Progress .

— Current scan information

File: name: co\LPJIANTABS SLOTO_S07.tif
Barcode: 16011535021652

Slat numbir: 1

— Statu

Scanning... ;I

— Progress

s

Scan progress 9
L

Carouzel progress 0% [0 of 1 glides completed)

Abort | [foze |

Figure20  Boite de dialogue Scan Progress (Avancement de la numérisation)
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Le journal Rapport de numérisation en
série (Carousel Report Log) regroupe
des informations sur la numérisation et

des messages relatifs aux erreurs
survenues pendant la série de
numeérisations.

La boite de dialogue Scan Progress (Avancement de la
numérisation) comprend une zone d'état ou s'affiche 1'état
d'avancement de chaque numérisation et de la série.

A la fin de la série de numérisation, le message Carousel run
completed (Série de numérisations terminée) s'affiche dans la
zone Status (Etat).

A la fin d'une série de numérisations, le journal Rapport de
numérisation en série (Carousel Report Log) s'affiche
automatiquement.

AGILENT SCANNER -- CA{QOUSEL REPORT LOG

Scanner SN: US1470PPB1
Carousel run requested from Slot 1 to Slot 29

Total number of slide(s) detected: 29.

Fri Apr 11 11:01:38 2008

Scamned image: D:'New Folder'US1470PPB1_123456782012 S01.tif
Scan completed.

Scamned image: D:'New Folder'US1470PPB1_251554817094 S01.tif
Scan completed.

Scamned image: D:'New Folder'US1470PPB1_251554819356_S01.tif
Scan completed.

Scamned image: D:'New Folder'US1470PPB1_251554819966_S01.tif
Scan completed.

Figure 21

40

Journal Rapport de numérisation en série (Carousel Report Log)

Pour rouvrir le journal Rapport de numérisation en série
(Carousel Report Log) final aprés la fermeture de la boite de
dialogue Scan Progress (Avancement de la numérisation),
accédez au chemin suivant :

C:\Program Files\Agilent\Microarray\Logs\CarouselRunLog.htm

Ce fichier est remplacé a chaque nouvelle série de numérisations.
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Référez-vous au Guide d'initiation
du logiciel Feature Extraction, livré
avec la documentation du scanner.

Mise en route 2

La série de numérisations terminée, vous pouvez retirer les diapositives
(voir la section "Etape 5 : retrait des diapositives", page 33).

Affichage du journal Rapport de numérisation en série pendant
I'exécution

Vous pouvez également afficher le journal Rapport de
numérisation en série (Carousel Report Log) a tout moment
pendant la série de numérisations.

¢ Dans la boite de dialogue Scan Progress (Avancement de la
numeérisation), cliquez sur View Report (Afficher le rapport) .

Consultation des données pendant ou apreés I'exécution

e Apreés le transfert des données d'une numérisation, ouvrez le
fichier dans le logiciel Agilent Feature Extraction ou un autre
programme.

Sivous avez installé Feature Extraction 10.x sur un autre disque dur, vous
devez transférer les fichiers d'image vers ce disque aprés la numérisation (voir
la section "Etape 5 : transfert des fichiers et archivage des données", page 42).

Abandon d'une numérisation
Vous pouvez arréter une numérisation ou une série de
numérisations a tout moment.

* Dans la boite de dialogue Scan Progress (Avancement de la
numérisation), cliquez sur le bouton Abort (Abandonner).

Le message suivant apparait.

Carousel Run Abort x|

@ Do you wank to abort the carousel run now?

Click fes to abort the run now; you may lose scan data.
Click Mo to abort the run after the current scan is done.
Click Cancel to cancel your abort command.

Yes I Mo | Cancel |

Figure 22 Message d'abandon d'une série de numérisations

L'abandon de la numérisation peut prendre une ou deux
minutes, méme si vous cliquez sur Yes (Oui). Les données
collectées sont enregistrées a des fins d'analyse ultérieure.
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2 Mise en route

Etape 5 : transfert des fichiers et archivage des données

¢ Alafin de la numérisation, transférez les fichiers vers un
autre dossier, si nécessaire.

Vous pouvez transférer le ou les fichiers vers quatre
emplacements :

Un nouveau dossier du répertoire initialement choisi
comme chemin de sortie, sur le disque local

Un autre dossier du disque local
Un dossier du réseau

Vous devrez ensuite transférer les données vers le PC sur
lequel se trouve le programme Feature Extraction.

Un CD ou un DVD

Chaque PC est équipé d'un graveur de DVD.

Il est essentiel d'archiver réguliérement les données du PC associé au
scanner en vue de libérer assez d'espace pour les numérisations a
venir. Lorsque le disque approche de la saturation, la fonction de
numérisation du scanner de puces a ADN est inhibée et un message
apparait.

La défragmentation réguliére du disque dur améliore les performances.
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Avant de numériser un ensemble de diapositives, vous aurez
peut-étre besoin de modifier les parametres d'image ou de
numérisation.

Ce chapitre décrit les parametres du tableau de numérisation,
puis explique comment les modifier, soit tous a la fois, soit un
par un.

-3 Agilent Technologies

43



3 Modification des paramétres de numérisation

Modification des parametres du tableau de numérisation

Vous pouvez modifier les parametres du tableau de
numérisation de deux manieres :

On appelle "profil" un ensemble de  * Tous a la fois, par le biais de profils
parametres d'image et de numérisation
qui, lorsqu'on le sélectionne, remplit le

tableau de numérisation avec les

e Un par un, grace aux listes déroulantes du tableau de
numérisation

valeurs saisies dans I'outil Profile  yous pouvez modifier les entrées dans l'ordre de votre choix,
Editor (éditeur de profils). 1,555 nous vous conseillons d'adopter I'ordre suivant (il vous
permettra de gagner du temps) :

a Sivous numérisez des diapositives tierces, commencez par
la "Création et modification de profils avec Profile Editor" ;
ainsi, vous disposerez d'une région de balayage plus
adaptée a vos diapositives que celles du tableau de
numérisation ou de 1'éditeur de profils.

b Que vous numérisiez des diapositives Agilent ou tierces,
vous pouvez également changer de profil dans un but de
"Modification des parametres du tableau de numérisation
par le biais de profils".

¢ Le changement, la modification ou la création de profil
effectué, passez a la "Modification de parametres pris
isolément dans le tableau de numérisation".

Si vous changez de profil apres avoir modifié isolément
certaines entrées, les valeurs du profil remplaceront les
valeurs modifiées.

d Une fois le profil sélectionné, saisissez (manuellement ou
automatiquement) des ID de diapositive. Cette opération
est obligatoire pour les diapositives dépourvues de
code-barres. Pour les diapositives Agilent, vous pouvez la
réaliser (voir la section "Slide ID (ID de diapositive)",
page 48).

Pour en savoir plus sur les différents parametres de
numérisation, référez-vous a la section "Parametres du tableau
de numérisation", page 48.
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Modification des paramétres de numérisation 3

Modification des parameétres du tableau de numérisation par
le biais de profils

¢ Dans la liste déroulante Profile (Profil), sélectionnez le profil
proposant les parameétres que vous souhaitez utiliser pour la
numérisation.

Frofile:

Figure 23  Liste déroulante Profile (Profil) de la fenétre principale de
Scan Control

Vous pouvez modifier les parameétres du profil sélectionné (voir
la section "Modification d'un profil existant", page 55) ou partir
de ce dernier afin de créer un nouveau profil (voir la section
"Création d'un profil", page 56).

A T'ouverture de la fenétre principale de Scan Control, les
colonnes contiennent des valeurs de parametres de
numérisation. Ces valeurs proviennent du dernier profil
sélectionné avant la fermeture du programme.

Agilent fournit six profils préchargés, a utiliser avec les puces a
ADN haute densité Agilent, les puces a ADN G3 Agilent et les
puces a ADN tierces.

AgilentHD _GX_2Color Puces d'expression de génes a 2 couleurs haute densité Agilent
AgilentHD GX_1Color Puces d'expression de génes a 1 couleur haute densité Agilent
AgilentHD CGH Puces CGH/CNV/ChIP haute densité Agilent
AgilentHD _miBNA  Puces miRNA haute densité Agilent
AgilentG3 CGH Puces CGH/CNV/ChIP G3 Agilent

Si vous numérisez des diapositives Agilent, sélectionnez le
profil correspondant a votre type de puce a ADN Agilent.

Si vous numérisez des diapositives tierces, vous devez modifier
certains parametres du tableau de numérisation ou créer un
profil a partir d'un profil existant.
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Modification des paramétres de numérisation

Modification de parameétres pris isolément dans le tableau
de numérisation

Le tableau de numérisation permet de modifier les valeurs
associées a certaines diapositives ou a certains groupes de
diapositives : pour ce faire, sélectionnez un élément du menu
déroulant que propose chaque colonne, sauf les colonnes Slide
ID (ID de diapositive) et Description.

1 Sélectionnez les cellules contenant les valeurs a modifier, par
I'une des méthodes suivantes :

Cliquez sur une cellule.
Cliquez sur un en-téte de colonne.

Pour sélectionner plusieurs cellules adjacentes dans une
méme colonne, faites glisser le curseur de haut en bas sur
les cellules a sélectionner.

Une fleche apparait a I'extrémité droite de la premiere
cellule sélectionnée.

Pour sélectionner des cellules non adjacentes dans une
méme colonne, maintenez la touche Ctrl enfoncée et
cliquez sur chacune des cellules.

Une fleche apparait a l'extrémité droite de la derniere
cellule sélectionnée.

2 Cliquez sur la fleche pour afficher la liste déroulante, puis
sélectionnez le parametre dans la liste.

Scan Region F

Agilent HD [ Bram) I
Full Slide [71 = 21.6mm)
Agilent HD [61 = 21.6mm

A AU BT ZTH -

Figure 24 Liste déroulante de parametres de région de balayage

Les parametres modifiés s'affichent en gras.

Pour obtenir la description des parametres, colonne par
colonne, référez-vous a la section "Parameétres du tableau de
numérisation", page 48.
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Modification des paramétres de numérisation 3

Rétablissement des valeurs du profil actuel dans le tableau de
numeérisation

Les valeurs de profil qui apparaissent lors de la réinitialisation
sont les valeurs initiales du profil sélectionné.

1 Sélectionnez les cellules contenant les valeurs a réinitialiser,
par l'une des méthodes suivantes :

Cliquez sur une cellule.
Cliquez sur un en-téte de colonne.

Pour sélectionner plusieurs cellules adjacentes dans une
méme colonne, faites glisser le curseur de haut en bas sur
les cellules a sélectionner.

Pour sélectionner des cellules non adjacentes dans une
méme colonne, maintenez la touche Ctrl enfoncée et
cliquez sur chacune des cellules.

Pour sélectionner toutes les cellules du tableau de
numérisation, cliquez sur l'en-téte Slot (Emplacement),
en haut a gauche du tableau.

2 Cliquez avec le bouton droit sur la zone sélectionnée, puis
cliquez sur Reset to Profile Value (Ramener a la valeur du
profil).

Reset to Profile Yalue

Fit Columnis) to Window
Best: Fit Column Sizes

Refresh Table

Figure25 Menu contextuel permettant de ramener tous les paramétres
sélectionnés a leurs valeurs initiales dans le profil actuel

Les parametres du profil actuel s'affichent dans la zone
sélectionnée.
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3 Modification des paramétres de numérisation

Parametres du tableau de numeérisation

Eile Tools Help

Start slot: |1 -

Slot Slide 1D

<Auto detects
| <Auto detect
| <Auto detect

<Auto detect>
| <Auto detects
| {Auto detects
| chuto detect
| <Auto detects

(RN I, B RN

<Auto detect
<Auto detect

o

Agilent Scan Control

End slat:

Charnels

m - Profile:

Scan Region

Agilent HD (61 x 21.6mm]
Agilent HD [E1 = 21.6mm]
Agilent HD [B1 = 21.6mm]
Agilent HD (61 % 21.6mm]
Agilent HD [B1 x 21 6mm]
Agilent HD [B1 = 21.6mm)]
Agilent HD [B1 # 21.6mm)]
Agilent HD (61 x 21.6mm]
Agilent HD (61 = 21.6mm]
Agilent HD [B1 = 21.6mm)]

Cette section décrit les parametres modifiables du tableau de
numeérisation. La section suivante explique comment les modifier.

AgilentHD_| o DOperator:
Rezolution | TIFF R PMT | GPMT | XDR Output Path Description
Sum 20kt 100% 1003 <MoxDR>  Di\ScanData
Sum 20kt 100% 100z <MoxDR>  D:\ScanDats
Bum 20kt 100% 100% ¢NoxDRy»  DM\ScanData
Sum 20kt 100% 1002 <MNoxDR>  D\ScanData
5 um 20kt 100% 1003 <Na®DR>  D:\ScanData
5um 06t 100% 100 <MexDRy  DiScerDate (DD
Bum 20kt 100% 100% <MNoxDR>  [\ScanData
Sum 20kt 100% 100 <MoxDR>  Di\ScanData
Sum 20bit  100% 100% <NoxDRr»  D:hScanData
Sum 20kt 100% 1005 <MNoxDR>  DMGcanData

Figure 26  Fenétre principale de Scan Control et tableau de numérisation avec parametres de profil préchargés

Slide ID (ID de

diapositive)

Ce parametre est l'identificateur de la diapositive.
L'identificateur de la diapositive sera incorporé au nom du
fichier image si le profil actuel le prévoit (voir la section
"Naming prefix 1 (Préfixe de nom 1) et Naming prefix 2 (Préfixe
de nom 2)", page 56).

Saisie automatique Si les diapositives comportent des
codes-barres conformes aux indications de la section "Spécifications
de codes-barres et d'étiquettes de code-barres", page 99, il est inutile
de saisir les ID de diapositives dans le tableau de numérisation
avant la série de numérisations. La mention "Auto detect"
(Détection automatique), dans la colonne Slide ID (ID de diapositive),
indique que le scanner reporte automatiquement les codes-barres pris
en charge par Agilent dans la table de numérisation, au fur et a
mesure de la numérisation des diapositives.

11 est également possible de saisir manuellement I'ID de diapositive.
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Saisie manuelle Vous devez saisir les identificateurs des
diapositives ne comportant pas de code-barres ou possédant un
code-barres d'un format non pris en charge. Pour ce faire,
utilisez le clavier ou un lecteur de codes-barres externe.

Si vous saisissez l'identificateur au clavier, vous devez tout
d'abord double-cliquer sur la cellule souhaitée. Ensuite, entrez
le code-barres ou un texte d'identification unique.

Recherche de codes-barres pris en charge par Agilent et
d'emplacements videsPour afficher les codes-barres pris en
charge par Agilent dans la colonne Slide ID (ID de diapositive)
et rechercher les emplacements vides, cliquez sur Tools >
Carousel Check (Outils > Controle du panier).

Le programme recherche d'abord les emplacements vides. 11
affiche la mention "No chip" (Puce absente) dans les cellules
correspondantes de la colonne Slide ID (ID de diapositive).
Ensuite, le programme lit les codes-barres de toutes les
diapositives et les place dans les cellules Slide ID (ID de
diapositive).

Channels (Voies Détermine la voie d'acquisition des informations a réunir :
de colorant) rouge seulement (par exemple, Cy 5), vert seulement (par
exemple, Cy 3) ou les deux. Cette sélection est sans effet sur la
durée de numérisation ; toutefois, la sélection d'une seule voie
divise la taille du fichier par deux.

Scanregion La région de balayage définit la partie numérisée de la

(Régionde diapositive. Elle doit étre assez grande pour que toute la partie

balayage) imprimée de la puce & ADN soit capturée. Elle doit toutefois
étre assez petite pour empécher que la numérisation passe a
proximité du code-barres et des bords opaques de la diapositive,
ce qui nuirait au bon fonctionnement de 1'autofocus.
L'utilisation d'une région de balayage aussi petite que possible
réduit en outre la durée de numérisation, ainsi que l'espace de
stockage nécessaire.

Agilent fournit une région de balayage adaptée a toutes les
diapositives haute densité et G3 Agilent, ainsi qu'une région
permettant de numériser entierement des diapositives de 25,4 x
76,2 mm (1" x 3") sans codes-barres.
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Modification des paramétres de numérisation

Scan resolution
(Résolution de
numeérisation)

(nm)

TIFF (Plage
dynamique des
fichiers TIFF)

Pour les diapositives tierces, vous aurez peut-étre besoin d'une
région de balayage personnalisée, mieux adaptée a la région
imprimée (voir la section "Création et modification de régions
de balayage avec Scan Region Editor", page 59).

Ce parametre réegle la résolution de numérisation (taille de
pixel) sur 2, 3, 5 ou 10 microns.

Avec la résolution de 10 microns, chaque rangée de pixels de
l'image TIFF représente la moyenne de deux lignes de balayage
acquises en sens inverse l'une de l'autre. Avec les résolutions de
5, 3 et 2 microns, vous pouvez sélectionner le double balayage
(qui permet d'utiliser des valeurs moyennes) ou acquérir une
seule ligne de balayage par ligne d'image.

Ce parametre regle la plage dynamique sur 16 bits ou 20 bits Le
PMT et I'électronique de traitement des signaux du scanner
G2565CA présentent une plage dynamique élargie. Grace a
l'option de fichier TIFF 20 bits, vous pouvez accéder a cette
plage élargie, qui permet de quantifier les signaux forts et les
signaux faibles lors d'une méme numérisation.

Le logiciel Scan Control permet toujours la numérisation 16 bits
XDR classique, comme indiqué plus bas.

Le tableau ci-dessous montre l'espace de stockage et la durée de
numérisation, en modes simple balayage et double balayage,
dans chacune des résolutions indiquées, pour une plage
dynamique TIFF de 16 bits ou de 20 bits. La région de balayage
est de 61 x 21,6 mm.

La barre d'état située en bas de la fenétre principale de Scan
Control fournit une estimation de l'espace de stockage et de la
durée d'exécution pour I'ensemble du panier de diapositives.
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Tableau 1 Espace de stockage et durée de numérisation, en modes simple
balayage et double balayage, pour une région de numérisation
haute définition Agilent de 61 x 21,6 mm

Résolution Espace de Espace de Durée de
stockage (Mo) stockage (Mo) numérisation
en mode 16 bits  en mode 20 bits  (min.)

Un seul balayage, 1300 1600 20
2 microns

Un seul balayage, 620 760 15
3 microns

Un seul balayage, 200 300 8
5 microns

Un seul balayage, 52 115 8
10 microns

Double balayage, 1300 1600 40
2 microns

Double balayage, 620 760 30
3 microns

Double balayage, 200 300 16
5 microns

Les numérisations en mode double balayage utilisent autant
d'espace de stockage qu'en mode simple balayage ; en revanche,
elles durent deux fois plus longtemps. Red PMT Gain (Gain du
PMT rouge) et Green PMT Gain (Gain du PMT vert)

Ce parametre définit le niveau de sensibilité des PMT de la voie
rouge et de la voie verte. Les PMT détectent la fluorescence
émise par la puce a ADN.

Le niveau de sortie par défaut (100 %) regle le gain sur le niveau
défini en usine ; c'est le parameétre recommandé pour les puces
a ADN Agilent. Il est possible de baisser indépendamment le
réglage de chaque voie de couleur jusqu'a 1 %.

Si une puce a ADN renvoie un signal de sortie saturé, vous
pouvez ramener la sensibilité des PMT a une plage qui permette
de lire toutes les informations.
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XDR (Rapport
XDR)

Output path
(Chemin de
sortie)

Description

Avant la mise a disposition de la plage dynamique TIFF 20 bits,
on utilisait la fonction eXtended Dynamic Range (XDR) sur le
scanner et sur le logiciel Feature Extraction, afin de capturer
toutes les données numérisées entre les motifs a signal tres
faible et les motifs a signal trés fort. Pour capturer toute la plage
dynamique des données, il est désormais possible d'utiliser le
mode TIFF 20 bits au lieu de la fonction XDR.

Lorsque la fonction XDR est active, le scanner numérise chaque
diapositive deux fois, avec des niveaux de sensibilité de PMT
différents. On obtient ainsi deux images liées, que le logiciel
Feature Extraction analyse ensemble pour créer un seul jeu de
données d'intensité allant du simple au millionieme et au-dela.

Le niveau de sensibilité supérieur est défini par le gain du PMT
rouge ou vert. Une fois activée, la fonction XDR est
automatiquement désactivée aux valeurs inférieures a 10 %.

Lorsqu'un rapport XDR est défini, le scanner effectue une
deuxieme numérisation avec des parametres de PMT plus bas.
Par exemple, si les PMT rouge et vert sont réglés sur 100 %, et
que le rapport XDR est réglé sur 0,1, la deuxiéme numérisation
sera effectuée avec un réglage de 10 % pour les PMT. Le plus bas
parametre de PMT disponible est de 1 %.

Le bouton de navigation permet de sélectionner un répertoire
de stockage des données de chaque numérisation. Agilent
recommande d'enregistrer les données dans un répertoire local
d'un disque dur secondaire. Il est également possible de
sélectionner un répertoire réseau. En cas de probléeme pendant
la numérisation, les données seront enregistrées dans un
dossier local temporaire et un avertissement apparaitra dans le
rapport sur la série de numérisations.

Description de chaque diapositive numérisée. Ces informations
sont intégrées aux données informatiques consultables dans le
logiciel Feature Extraction.
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Utilisation des outils

Création et modification de profils avec Profile Editor 55

Création et modification de régions de balayage avec Scan Region Editor 59
Configuration de I'activation et de la désactivation des lasers 63

Outils supplémentaires 65

Les options du menu Tools (Outils) permettent de créer ou de
modifier un profil ou une région de balayage, ou encore de
programmer les lasers de telle maniére qu'ils se mettent en
marche et s'arrétent automatiquement. Ce chapitre présente
I'utilisation de ces outils.

Tools Wi
Profile Editar. ..

Scan Region Editar, ..
Laser duko ORJOFF Settings. ..

Log File Finder. ..

Figure 27  Menu Tools (QOutils)
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Profile Editor
(Editeur de
profils)

<Default>

AgilentHD_GX_
2Color

AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD_miRNA
AgilentG3_CGH

Scan Region Editor
(Editeur de régions
de balayage)

Lasers Auto On/Off
Settings (Paramétres
d'activation/de
désactivation auto.
des lasers)

L'éditeur de profils permet de modifier les parameétres des
profils fournis avec le logiciel :

Profil dont les parameétres sont chargés lors de l'installation

Puces d'expression de genes a 2 couleurs haute densité Agilent

Puces d'expression de genes a 1 couleur haute densité Agilent
Puces CGH/CNV/ChIP haute densité Agilent

Puces miRNA haute densité Agilent

Puces CGH/CNV/ChIP G3 Agilent

Vous pouvez également créer des profils a partir des profils
existants.

Vous aurez peut-étre a numériser des régions de puce non
installées par défaut. L'éditeur de régions de balayage vous
permet de créer de nouvelles régions a balayer.

Cette boite de dialogue permet de régler 'appareil de telle
maniere qu'il active et désactive automatiquement les lasers a
certains moments, afin de prolonger leur durée de vie.
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Création et modification de profils avec Profile Editor

Modification d'un profil existant

Il est impossible de supprimer le
profil par défaut (<default>). Vous
pouvez supprimer tous les autres
profils, y compris ceux que vous
avez créés a partir du profil
<default>.

Vous pouvez modifier et enregistrer un profil existant. Il vous
est également possible de modifier un profil, puis d'enregistrer
la version modifiée sous un nouveau nom (voir la section
"Création d'un profil", page 56).

1 Dans la barre de menus, cliquez sur Tools > Profile Editor
(Outils > Editeur de profils ; voir la Figure 27).

Profile Editor

Current Prafils: <Diefault = Irnport | Export |
Bl Ge
Description Defaulk configuration settings z
= r
Drye channel R+i3 Save L5,
Scan region Agilent HD (A1 x 21.6mm)
Scan resolution S um
Tiff file dynamic range 16 bit Her
Red PMT gain 100%.
Green PMT gain 100%:
DR Ratio <Mo KDR=
= :
Qutput path o

Slide description

Maming prefix 1 <Instrument Serial # =

Maring prefix 2 <Slak # >
Compress TifF Mo
Splitfrotate image To

Close

Figure 28  Profile Editor (Editeur de profils)

2 Sélectionnez le profil & modifier.

3 Modifiez les parameétres d'image et de numérisation a l'aide
des options décrites dans les sections "Modification des
parametres du tableau de numérisation", page 44 et
"Parametres de profil absents du tableau de numérisation",
page 56.

4 Cliquez sur Save (Enregistrer).
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Création d'un profil

Vous pouvez créer un profil a partir de n'importe quel profil
existant : il vous suffit d'enregistrer le profil existant sous un
nouveau nom.

1 Cliquez sur Tools > Profile Editor (Outils > Editeur de profils).
2 Sélectionnez le profil a enregistrer sous un nouveau nom.

3 Cliquez sur Save As (Enregistrer sous) pour enregistrer le
fichier existant sous un nouveau nom.

4 Saisissez le nom, puis cliquez sur Save (Enregistrer).

b Modifiez les parameétres d'image et de numérisation a l'aide
des options décrites dans les sections "Modification des
parametres du tableau de numérisation", page 44 et
"Parametres de profil absents du tableau de numérisation",
page 56.

6 Cliquez sur Save (Enregistrer).

Parametres de profil absents du tableau de numeérisation

Les parametres suivants n'apparaissent pas dans le tableau de
numeérisation. Ils s'appliquent a toutes les numérisations de la
série.
Naming prefix1 Dans Scan Control, les noms de fichier des numérisations
(Préfixe de nom 1) et  standard comprennent trois segments :
Naming prefix 2 Préfizel_Préfize2_Numérodenumérisation.tif.
(Préfixe de nom 2)
Pour les numérisations XDR, le logiciel ajoute un segment (_H ou
_L) destiné a différencier I'image XDR avec haut niveau de
sensibilité (_H) et I'image XDR avec bas niveau de sensibilité (_L) :

Préfixel _Préfixe2_Numérodenumérisation_H.tif
Préfixel _Préfixe2_Numérodenumérisation_L.tif

Par défaut, Préfixel est le numéro de série de 'appareil
(Instrument Serial #), mais vous pouvez sélectionner 1'ID de
diapositive (Slide ID) ou un préfixe personnalisé.

Par défaut, Préfixe? est 1'ID de diapositive (Slide ID), mais vous
pouvez sélectionner le numéro d'emplacement (Slot #), la date et
I'heure de numérisation (Scan Date Time) ou un préfixe personnalisé.
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= Image File Settings

Qubput path [
Slide description
Marning prefix 1 <Instrument Serial # =
<Customize: =
Customize <Slide ID=
Compress Tiff «<5Scan DateTime >
Splitfrotate image <Slat #=

Slide ID (ID de diapositive) : si vous sélectionnez cette
option, la valeur de la cellule Slide ID apparait dans le
nom de fichier. Si Slide ID est réglé sur <Auto detect>
(Détection automatique), le code-barres apparait dans le
nom de fichier.

Slot # (N° d'emplacement) : insére le numéro de
I'emplacement oul se trouve la diapositive numérisée dans
le nom de fichier.

Scan DateTime (Date et heure de numérisation) : si vous
sélectionnez cette option, le logiciel utilise I'norodatage, au
format AAAAMMJJHHMM.

Customize (Personnaliser) : si vous sélectionnez cette
option, saisissez un préfixe personnalisé (36 caracteres
maximum).

Le logiciel Scan Control attribue automatiquement le numéro
de numérisation.

Pour ce faire, il compare le nom de fichier de la nouvelle
numérisation aux noms des fichiers du répertoire de
données sélectionné.

Si la chaine Préfixel_Préfixe2 est unique, il régle le numéro
de numérisation sur SO1.

S'il existe déja un fichier de méme nom, il incrémente le
numéro de numérisation jusqu'a obtenir un nom de fichier
unique.

Exemple

US4510PP02_251485023883_S03.tif
¢ Numéro de série de l'appareil : US4510PP02
e ID de diapositive : 251485023883
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Compress TIFF
(Compression
TIFF)

Split/rotate image
(Division/rotation
de I'image)

¢ Numéro de numérisation : S03. Il s'agit du troisiéme fichier
de numérisation associé au méme numéro de série d'appareil
et au méme identifiant de diapositive dans le répertoire.

La compression des fichiers TIFF permet de réduire 1'espace
de stockage final occupé par les images numérisées.

L'algorithme de compression utilisé (algorithme LZW) réduit les
besoins en espace de stockage de 20 a 70 %.

Certains programmes d'analyse nécessitent des données
d'images monochromes, tournées a 90 degrés. Si vous réglez
I'option Split/Rotate (Division/Rotation) sur Yes (Oui), le fichier
couleur est divisé en deux fichiers monochromes, et les images
sont tournées a 90 degrés et inversées.

Un exemple d'image est illustré ci-dessous :

5] —>

YBCD

Si le nom automatiquement attribué au fichier avant sa division
est Nomfichier, les fichiers issus de la division portent les noms
Nowmfichier_green (vert) et Nomfichier_red (rouge).

Si vous avez créé le fichier de sortie avec une seule voie de
colorant, vous devez sélectionner cette option pour faire pivoter
l'image, bien qu'il soit inutile de diviser le fichier.

Cette option n'est disponible que pour les numérisations a plage
dynamique TIFF de 16 bits.

Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Utilisation des outils 4

Creation et modification de régions de balayage avec
Scan Region Editor

La région de balayage définit la partie  Si vous utilisez des diapositives tierces, vous pouvez créer une
numérisée de la diapositive. Plus elleest  région de balayage personnalisée ou modifier une région
grande, plus la durée de numérisationest  existante. La taille maximale de la région de balayage est de
longue. Les différences entre régions de 71 x 21 6 mm. La nouvelle région apparait parmi les options du

balayage tiennent a des facteurs tels que 1165 de numérisation et dans Profile Editor.
la taille et la position des étiquettes de

codes-barres, ainsi que ['utilisation de
verre dépoli.

Ouverture de Scan Region Editor

A partir de la fenétre principale de Scan Control

¢ Dans la barre de menus, cliquez sur Tools > Scan Region
Editor (Outils > Editeur de régions de balayage ; voir la Figure 27).

i
Fle telp
Oz % %
Scanner G2505C
e e - WwIDTH
wg R / \
\ 1
e
i
i
| K. e
4 [310.1.90]
n Min upper eft comer
|
G
a M bowier right cormer
- [74.20, 2350)
| Sy
Siide

Slide Holder /

% Pos mm] | Pos (mm) | Width [mm) | Height (mm) |«

11.00 1.90

.00 10.90 61.00 200
Fast71mm 3 1.90 .00 200
PGWTest! .00 1.90 61.00 200
PGWTest2 11.00 1.90 61.00 2.00 =

Figure 29  Scan Region Editor (Editeur de régions de balayage)
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A partir du menu Démarrer

¢ Dans la barre des taches, cliquez sur Démarrer >
Programmes > Agilent Life Sciences > Scan Region Editor.

Il est impossible d'accéder a 1'élément de menu Scan Region
Editor dans la fenétre principale pendant le fonctionnement du
scanner. Pour créer et modifier des régions de balayage, vous
devez passer par le menu Démarrer.

Création d'une région de balayage avec Scan Region Editor

Lors de la création et de 1'utilisation de régions de balayage,
vérifiez que la région se trouve au moins a 4 mm de 1'étiquette
de code-barres et qu'elle ne chevauche aucune autre zone
opaque ou translucide de la diapositive.

1 Dans la barre de menus de Scan Region Editor, cliquez sur
File > New Region (Fichier > Nouvelle région).

. Add New Region M= 3
MName: ||
Ranges{mm):
* mm 310 - 69.10
- i 190 - 2340
Width: mm 500 - 71.00
Height: mm 010 - 2160
Save I Exit |

Figure 30  Boite de dialogue Add New Region (Ajouter une région).

2 Saisissez le nom ou la taille de la région.

3 Saisissezles dimensions de la région (en mm), conformément
aux critéres ci-dessous.

Les valeurs non valides seront marquées en rouge.
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Création d'une région de balayage avec Scan Region Editor

X Position du coin supérieur gauche, selon l'axe X. Cette valeur
et la position selon l'axe Y servent a placer la région sur la
diapositive.

Y Position du coin supérieur gauche, selon 1'axe Y.

Width (Largeur) Largeur de la région de balayage, mesurée selon l'axe X,

a partir du coin supérieur gauche.

Height (Hauteur) Hauteur de la région de balayage, mesurée selon l'axe Y,
a partir du coin supérieur gauche.
Ranges (Plages) Plages de valeurs admissibles pour chaque dimension.
4 Cliquez sur Save (Enregistrer).

Si les valeurs sont valides, Scan Region Editor s'ouvre.
La nouvelle région apparait dans Scan Region Editor.

' Poz [mm] |*idth [mm] | Height [mm]
Custom Region 1 [215 [135 [ 7090 | 21.50

Figure 31 Liste des régions de balayage

Show Custom Lorsque cette case est activée, seules les régions de balayage
regions only personnalisées s'affichent dans la liste de Scan Region
(Afficher Editor. Lorsque la case est désactivée, les régions fournies
uniquement par Agilent apparaissent également dans la liste ; toutefois,
les régions vous ne pouvez pas les modifier a I'aide de Scan Region
personnalisées) Editor.

5 Fermez Scan Region Editor.

Les nouvelles régions apparaissent maintenant dans les
listes de régions de balayage de Profile Editor et du tableau
de numérisation.
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Modification d'une région de balayage pour les diapositives
tierces

Vous ne pouvez modifier que les régions de balayage
personnalisées. Il est impossible de modifier ou de supprimer
les régions fournies par Agilent.

Lors de la création et de l'utilisation de régions de balayage,
vérifiez que la région se trouve au moins a 4 mm de 1'étiquette
de code-barres.

1 Dans Scan Region Editor, sélectionnez la région a modifier.

2 Dans la barre de menus, cliquez sur File > Open Region
(Fichier > Ouvrir région).

La boite de dialogue Modify Region (Modification de région)

s'ouvre.
& Modify Region JSI=] B3
Hame: I
Ranges(mrm):
* 4.00 mm 310 - B30
A 2.00 mm 180 - 2340
Wicith:  |6.00 mm 500 - 7010
Height: |1.00 mm 010 - 21.50
Save | Exit |

Figure 32  Boite de dialogue Modify Region (Modification de région)

3 Modifiez le nom ou la taille de la région.

4 Modifiez les dimensions de la région, conformément aux
criteres décrits a la section "Création d'une région de
balayage avec Scan Region Editor", page 60.

5 Cliquez sur Save (Enregistrer).
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Configuration de I'activation et de la désactivation des lasers

Pour prolonger la durée de vie des lasers du scanner, vous
pouvez configurer Scan Control de telle maniére qu'il les active
ou les désactive automatiquement. Ainsi, les lasers seront préts
a numériser a un certain moment et s'arréteront automatiquement
a une certaine heure ou apres un certain temps d'inactivité.

Quels que soient les parametres d'activation et de désactivation
automatiques des lasers :

¢ Vous pouvez activer ou désactiver manuellement les lasers a
tout moment.

* A l'ouverture de Scan Control, les lasers sont mis sous tension.

¢ Sile scanner a une numérisation en cours a I'heure de
désactivation indiquée, les lasers restent activés.

Programmation de I'activation ou de la désactivation
automatiques des lasers
1 Dans la barre de menus, cliquez sur Tools > Laser Auto

ON/OFF Settings (Outils > Parameétres d'activation/de
désactivation auto. des lasers ; voir la Figure 27).

2 Faites un double clic sur No (Non) pour régler le parametre
Enable laser auto ON/OFF (Autoriser I'activation/la
désactivation auto. des lasers) sur Yes (Oui).
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Laser Auto ON/OFF Settings

El
Enable laser auko OM/OFF Yes

[l
B Turn OM daily Every day

Turn M at 700 AM
Bl
B Turn OFF daily es

Turn CFF at §:00 PM
B Turn OFF when idle Yes

Idle far{hr) 1

Turn Lasers on Mow | Ok | Cancel |

Figure 33  Page de propriétés Laser Auto ON/OFF Settings

(Paramétres d'activation/de désactivation auto. des lasers)

Si ce paramétre est réglé sur NO (NON), vous devez activer et désactiver
les lasers manuellement, comme indiqué a la section suivante.

Turn ON daily
(Activer tous
les jours)

Turn OFF daily
(Désactiver tous les jours)

Turn OFF when idle
(Désactiver en cas
d'inactivité)

Sélectionnez Weekdays only (Jours de semaine uniquement)
ou Weekends et indiquez l'heure d'activation des lasers, les
jours de semaine ou les week-ends.

Sélectionnez Yes (Oui) et indiquez 'heure de désactivation
des lasers, les jours de semaine et les week-ends.

Sélectionnez Yes (Oui) et définissez la durée d'inactivité du
scanner apres laquelle les lasers seront désactivés. Si vous
sélectionnez No (Non), le scanner ne désactivera pas les
lasers dans ce cas.

3 Cliquez sur OK.

Activation et desactivation manuelles des lasers

1

Accédez a la page de propriétés Laser Auto ON/OFF Settings
(Parametres d'activation/de désactivation auto. des lasers).

Cliquez sur Turn Lasers on Now (Activer les lasers maintenant)
ou Turn Lasers off Now (Désactiver les lasers maintenant).

Cliquez sur OK.
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Outils suppléementaires

Le menu Tools (Outils) propose également les outils
supplémentaires suivants.

Unlock Door (Déverrouiller le capot)

L'outil de déverrouillage du capot (Tools > Unlock Door [Outils
> Déverrouiller le capot]) permet de déverrouiller
manuellement le capot en cas de probleme de verrouillage, par
exemple, si on léve le capot lors du déverrouillage automatique,
a la fin d'une série de numérisations.

Reset Calibration Warnings (Réinitialiser les avertissements
d'étalonnage)

En fonctionnement normal, le scanner G2505C étalonne les
PMT avant chaque numérisation, et les lasers, lors de
l'initialisation et aprés chaque série de numérisations. En cas de
probléme d'étalonnage ou de forte variation par rapport a
I'étalonnage précédent, le logiciel du scanner enregistre
I'anomalie et insére des avertissements dans le journal de la
série de numérisations.

L'avertissement relatif a I'étalonnage des PMT est émis lorsque
la tension des PMT change de plus de 20 % par rapport a la
valeur d'étalonnage précédente.

Les avertissements relatifs a I'étalonnage des lasers
interviennent lorsque les lasers n'atteignent pas la puissance
définie avant la fin de la période de mise en température. Dans
ce cas, le systeme émet un avertissement et réétalonne les lasers
a 80 % de la puissance indiquée. Scan Control reconfigure le
fichier TIFF pour compenser la baisse de puissance des lasers.

Vous pouvez réinitialiser ces avertissements : pour ce faire,
sélectionnez Tools > Reset Calibration Warnings (Outils >
Réinitialiser les avertissements d'étalonnage).
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Si I'étalonnage échoue de nouveau et que les avertissements
réapparaissent, contactez le représentant local du service
clientele Agilent.

Etalonnage étendu des lasers

L'étalonnage normal des lasers ne mesure pas leur puissance de
sortie maximale. L'outil d'étalonnage étendu procede a une
vérification plus compléte du sous-systeme de laser. Si vous
recevez régulierement des messages d'avertissement
d'étalonnage des lasers, I'équipe d'assistance Agilent pourra
vous demander d'utiliser I'outil d'étalonnage étendu, puis de lui
envoyer les fichiers journaux résultants par e-mail.
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Maintenance du systeme

Bien entretenu, le scanner de puces a ADN fonctionne sans
heurt. En cas de doute sur l'utilisation ou l'entretien du scanner
de puces a ADN, contactez le représentant local du service
clientele Agilent ; il répondra a vos questions.

Maintenance Ces sections décrivent les opérations de maintenance logicielle
planifiée et matérielle a effectuer régulierement pour un fonctionnement
efficace du scanner de puces a ADN.

Prévention des  Cette section propose des conseils d'utilisation et d'entretien du
problemes scanner de puces a ADN, dans un but de prévention des
problémes.

Maintenance logicielle planifiée
Pour préserver les performances du PC et du systéeme
d'exploitation MS Windows, effectuez les taches suivantes :

¢ Au moins une fois par semaine, vérifiez 1'espace disque et
archivez les données selon les besoins.

¢ Une fois par semaine, supprimez les éventuels fichiers
temporaires (fichiers *.mp et *.tmp) du dossier C:\Temp.

¢ Sile systeme est lent, défragmentez le disque dur a l'aide d'un
logiciel destiné a cet usage.
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Maintenance matérielle planifiée

Pour préserver les performances du scanner de puces a ADN,
exécutez les taches suivantes :

Inspection des ouies d'aération et du filtre a air

La bonne circulation de I'air dans le scanner de puces a ADN est
essentielle au bon fonctionnement du systéme. L'obstruction
des ouies d'aération et le colmatage du filtre a air peuvent nuire
aux performances.

Ouies d'aération Une fois par semaine, vérifiez qu'aucune ouie
n'est obstruée par de la poussiére, des débris, des meubles ou
d'autres appareils.

Filtre a air Une fois par mois, vérifiez que le filtre a air du
scanner de puces a ADN n'est pas trop sale, comme suit :

1 Mettez le scanner de puces 2 ADN hors tension.

2 Ouvrez et déposez le capot du filtre a air, sur le c6té droit du
scanner de puces a ADN.

Capot de filtre
_—aair

(amovible)

Figure 34  Ouverture et dépose du capot du filtre a air

3 Sortez le filtre a air du boitier et inspectez-le visuellement.
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Capot du filtre a air

Filtre
a air

Figure 35 Dépose du filtre a air

Nettoyage du filtre a air
Si le filtre a air est trés sale ou n'a pas été nettoyé depuis
six mois, nettoyez-le.
1 Lavez le filtre a air a I'eau tiéde.
2 Essorez le filtre a air.
Veillez a bien extraire tout l'excédent d'eau du filtre a air.

3 Laissez le filtre a air sécher complétement avant de
l'installer. Vous pouvez utiliser des serviettes en papier pour
sécher le filtre.

4 Reposez le filtre a air dans le boitier et fermez le capot.

Vérifiez que le filtre a air a été remis en place, une fois sec.
L'absence du filtre a air peut entrainer I'accumulation de
poussiere a l'intérieur de I'appareil et nuire aux
performances.

Vous pouvez commander des filtres a air (réf. 3150-0956)
directement aupres du représentant local du service clienteéle
Agilent.
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Prévention des problemes

Pour bien entretenir le scanner de puces a ADN et protéger ses
performances, effectuez la maintenance planifiée décrite
ci-dessus et suivez ces conseils.

Prévention de la perte de données

* Evitez de charger des logiciels qui sollicitent fortement le
processeur : cela peut perturber l'acquisition des données
lors de la numérisation.

Prévention des dommages dus aux conditions ambiantes

¢ Maintenez les liquides et les vapeurs a 1'écart du scanner
de puces a ADN.

¢ Limitez et controlez les fluctuations de température.

Evitez d'exposer le scanner de puces a ADN a la lumiere du
soleil. Ne placez pas le scanner de puces a ADN a proximité
d'une fenétre, méme équipée d'un store ou de rideaux.

Le soleil peut provoquer un échauffement inégal du boitier
du scanner et nuire au bon alignement de I'optique.

Avant toute numérisation, assurez-vous que la température
du laboratoire respecte les spécifications de température

de fonctionnement du scanner de puces a ADN. Pour des
performances optimales, n'utilisez le scanner que dans

la plage de températures de fonctionnement indiquée (voir la
section "Spécifications du scanner de puces a ADN", page 96).

e Maitrisez I'humidité.

Le scanner de puces a ADN peut se révéler sensible a
I'humidité, lorsqu'elle atteint le point de saturation. Pour des
performances optimales, n'utilisez le scanner que dans la
plage d'humidité indiquée (voir la section "Spécifications du
scanner de puces a ADN", page 96). Respectez toujours un
temps de stabilisation thermique sur site de 10 heures avant
d'ouvrir I'emballage.
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Maintien des performances matérielles

Evitez de déplacer le scanner de puces a ADN.

Le déplacement du scanner de puces a ADN est susceptible
de nuire aux performances du systeme. Contactez le
représentant local du service clientéle Agilent pour
bénéficier d'une aide lors du déplacement du scanner de
puces a ADN.

Placez le scanner de puces a ADN sur une table ou un établi
solide.

Evitez d'incliner le scanner de puces a ADN.

Pour prolonger la durée de vie des lasers, configurez le
systeme de maniere qu'ils soient automatiquement activés et
désactivés (voir la section "Configuration de l'activation et de
la désactivation des lasers", page 63, au chapitre 4).

Apres la mise sous tension, respectez le temps de
préchauffage et de stabilisation des lasers. Le temps de
préchauffage maximum est de 30 minutes.

Nettoyez le fond du panier a l'aide d'un chiffon. Proscrivez
les solvants.

N'utilisez pas d'acétone ni d'autre solvant pour nettoyer
l'appareil.

Ne touchez pas l'engrenage situé dans la zone du panier.

Ne retirez pas les capots. N'essayez pas d'accéder aux composants
internes ni de réparer ces composants. Vous risqueriez de vous

exposer a des hautes tensions ou a des rayonnements laser nocifs.
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Dépannage du systeme

Le scanner de puces a ADN Agilent est concu

pour offrir une grande facilité d'utilisation et nécessiter peu de
maintenance. Si vous ne parvenez pas a résoudre un probléme
affectant le systeme, lisez ce chapitre de bout en bout avant de
contacter le représentant local du service clientele Agilent.

Support technique  Cette section contient des informations importantes concernant
le support technique.

Questions  Cette section propose des réponses aux questions fréquentes en
fréquentes matiére de support et de maintenance.

Dépannage Cette section décrit les témoins et le remplacement des fusibles.
matériel

Dépannage Cette section décrit les précautions a prendre pour récupérer
logiciel les logiciels et données installés sur le disque dur, en cas
d'utilisation du CD de restauration.

Messages d'erreur  Cette section présente les messages d'erreur importants,
du scanner avec les solutions correspondantes.
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Support technique

Le systeme de scanner de puces a ADN Agilent bénéficie d'un
support technique. Avant d'appeler le représentant local du
service du service clientéle Agilent, lisez le reste de ce chapitre.

Acceés au support technique via Internet

Le logiciel est livré avec une URL par défaut qui donne acces au
support technique Agilent concernant le scanner de puces a
ADN.

¢ Cliquez sur Help > Technical Support (Aide > Support
technique).

Support pour PC

En cas de probleme avec le PC, consultez la documentation
d'accompagnement de ce dernier.

Si vous ne parvenez toujours pas a résoudre le probleme,
contactez le représentant local du service clientéle Agilent ou
cliquez sur Help > Technical Support (Aide > Support
technique).

Support pour scanner de puces a ADN

En cas de probléme de scanner de puces a ADN nécessitant
l'intervention du service clientele Agilent, vous devrez peut-étre
fournir les derniers fichiers journaux de diagnostic créés par le
logiciel Scan Control. Ces fichiers se trouvent dans le dossier
C:\Program Files\Agilent\Microarray\Logs.

Le programme HyperTerminal permet de capturer d'autres
informations de diagnostic, dont les résultats de l'autotest de
mise sous tension. Pour en savoir plus sur la configuration et
l'utilisation de ce protocole de communication, référez-vous a la
section "Utilisation d'HyperTerminal pour l'acquisition de
données de diagnostic", page 83.

Le scanner de puces a ADN Agilent est identifié par un numéro
de série a 10 caracteres. Celui-ci figure sur des étiquettes,
apposées a deux endroits sur le scanner de puces a ADN : dans
la baie du panier et derriere le capot de filtre.
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Dans vos échanges avec le service clientele Agilent, concernant
le scanner de puces a ADN, veillez a bien indiquer le numéro de
modele et le numéro de série.

Reportez le numéro de série du scanner de puces a ADN
Agilent, ainsi que le numéro de version logicielle et la date
d'installation dans les espaces réservés a cet effet, ci-dessous (si
vous imprimez cette page) ou sur un papier que vous
conserverez a proximité du scanner.

Informations sur le scanner

N° de modele :

N° de série :

Date d'installation :

N° de version du logiciel :

N°/Date de mise a jour du logiciel :

N°/Date de mise a jour du logiciel :

Recherche des informations de version du logiciel du scanner

1 Pour trouver les informations de version, cliquez sur Help >
About (Aide > A propos) dans la barre de menus.

2 Pour fermer le programme, cliquez sur OK.
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Questions fréquentes

Tableau 2 Questions fréquentes

Les sections suivantes comprennent des questions fréquentes
(Frequently Asked Questions, FAQ), avec les réponses associées
; elles peuvent faciliter 1'utilisation et la maintenance du
systeme de scanner de puces a ADN Agilent, ainsi que son
dépannage.

Question fréquente

Réponse

Je veux déplacer le scanner de puces
a ADN.

Est-il possible d'enregistrer les fichiers
sur le réseau lors de la numérisation ?

0u trouver des informations de support
(pilotes, guides, solutions de dépannage,
etc.) pour le PC?

Je ne peux pas ouvrir le capot supérieur
pour accéder au panier.

Le logiciel Scan Control ne répond pas.

Le changement de place peut nuire aux performances du scanner. Contactez le
représentant local du service clientéle Agilent pour bénéficier d'une aide lors du
déplacement du scanner et assurer son bon fonctionnement par la suite.

Agilent recommande d'enregistrer les fichiers de données directement sur le
disque dur local. Il est également possible de les enregistrer dans un répertoire
réseau. En cas de probléme pendant la numérisation, les données seront
enregistrées dans un dossier local temporaire et un avertissement apparaitra
dans le rapport sur la série de numérisations.

En cas de probléme avec le PC, consultez la documentation d'accompagnement
de ce dernier. Si vous ne parvenez toujours pas a résoudre le probleme,
contactez le représentant local du service clientéle Agilent.

N'essayez pas d'ouvrir le capot de force : cela pourrait endommager le scanner
de puces a ADN.

1 Appuyez sur le capot pour détendre le ressort, si nécessaire, puis essayez
d'ouvrir le capot. Si le probléme persiste, passez a |'étape 2.

2 Fermez, puis rouvrez le logiciel Scan Control.

3 Essayez d'ouvrir le capot.

4 Sile capot ne s'ouvre toujours pas, fermez Scan Control et mettez le scanner
de puces a ADN hors tension, puis de nouveau sous tension.

5 Essayez d'ouvrir le capot.

6 Sile capot résiste toujours, contactez le représentant local du service
clientéle Agilent.

Scan Control ne répond plus : le message d'état n'a pas changé depuis plus de
15 minutes et il est impossible de fermer le programme. Procédez comme suit :

1 Ouvrez le Gestionnaire des taches Windows (Ctrl + Alt + Suppr) et fermez
Scan Control. Ensuite, rouvrez Scan Control.

2 Sile probléme persiste, réinitialisez le PC, mettez le scanner de puces a ADN
hors tension, puis de nouveau sous tension, attendez que le témoin jaune
s'éteigne et enfin, rouvrez Scan Control.
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Question fréquente

Réponse

Lors de l'insertion d'une diapositive,
le bras de chargement automatique s'est
bloqué a mi-chemin. Que faire ?

Le scanner de puces a ADN est sous
tension, mais le témoin jaune ne s'éteint
pas au bout de 20 minutes.

Le scanner est sous tension et Scan
Control est ouvert, mais le scanner ne
scanne pas.

1

Selon la moindre résistance, poussez ou tirez le bras de chargement
automatique au maximum. Ne le forcez pas.

Fermez et rouvrez le logiciel Scan Control.

Si le probléme persiste, contactez le représentant local du service clientéle
Agilent.

Vérifiez que le PC est sous tension.

Vérifiez que le cable USB est branché entre le PC et le scanner de puces
a ADN.

Contactez le représentant local du service clientéle Agilent.

Fermez, puis rouvrez le logiciel Scan Control.

Le scanner de puces a ADN doit étre sous tension avant le démarrage de
Scan Control. Si vous ouvrez d'abord Scan Control, la connexion n'est pas
établie au démarrage du scanner.

Contactez le représentant local du service clientéle Agilent.
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Dépannage matéeriel

Le scanner de puces a ADN comporte trés peu de pieces
réparables par l'utilisateur. Vous pouvez intervenir en fonction
des erreurs signalées par les témoins d'état, a I'avant de
l'appareil. Vous pouvez également remplacer les fusibles qui
protegent le systeme. Pour tout autre probleme, y compris les
bourrages, contactez le représentant local du service clientele
Agilent.

En cas de probleme avec le PC, référez-vous aux informations
de support de la section "Support pour PC", page 74.
Dépannage avec les témoins d'état

Le panneau avant comprend trois témoins d'état indiquant 1'état
actuel du scanner de puces a ADN.

Témoins - /_)"'( s =§{;§}
d'état ¢
— 0=

|
Figure 36 Emplacement des témoins d'état

Le Tableau 3 décrit les mesures a prendre, compte tenu de 1'état
des témoins.
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Tableau 3 Etat des témoins
Etat des voyants Causes Action
possibles suggeérée
Vert Jaune Rouge
Eteint Eteint Eteint Scanner non alimenté Effectuez les vérifications suivantes
* L'interrupteur de mise sous
tension est en position d'allumage.
* Le cordon d'alimentation est
branché a une prise sous tension.
* Lesfusibles de |'alimentation ne
sont pas grillés.
Clignote une fois Clignote Clignote Test des voyants lors de Aucune action requise.
une fois une fois la mise sous tension
(durée <1s)
Clignote Clignote Eteint Autotest de mise sous Aucune action requise. Utilisez
tension en cours HyperTerminal pour acquérir des
informations de diagnostic (voir la
section "Utilisation d'"HyperTerminal
pour I'acquisition de données de
diagnostic”, page 83).
Eteint Clignote Eteint Tentative de connexion au Installez le logiciel Scan Control 8.0,
(éteint 20 s PC si ce n'est pas déja fait.
allumé 20 s)
Eteint ou allumé Clignote Eteint Téléchargement du Aucune action requise.
(toutes les programme et initialisation
secondes du DSP
ou toutes
les 1.3 s)
Allumé Allumé Eteint Préchauffage des lasers. Patientez. Le temps de
L'appareil n'est pas prét a préchauffage maximum est de
effectuer une numérisation. 30 minutes.
Allumé Eteint Eteint L'appareil est prét a Aucune action requise.
numériser
Clignote Eteint Eteint Numeérisation en cours Aucune action requise.
Tout état Tout état Allumé Erreur détectée Contactez le représentant local
du service clientéle Agilent.
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AVERTISSEMENT

Controle et remplacement des fusibles du scanner

Le scanner de puces a ADN comporte trois fusibles : deux pour
I'alimentation, un pour le laser rouge. Ces fusibles se trouvent a
l'arriére du scanner de puces a ADN. Les fusibles de
I'alimentation sont montés immédiatement au-dessus de la
prise d'alimentation. Le fusible du laser est placé dans un
porte-fusible circulaire, a gauche de la prise d'alimentation.

Vous pouvez commander des fusibles directement aupres

d'Agilent Technologies.

Débranchez toujours le cordon d'alimentation avant de contrdler
ou de changer les fusibles.

Controle et remplacement des fusibles de I'alimentation Si le
scanner de puces a ADN ne s'allume pas, alors que - vérification
faite — la prise murale est sous tension, controlez les fusibles et
changez-les, si nécessaire. Pour ce faire, placez-vous a l'arriére
de l'unité.

1 Débranchez le cordon d'alimentation.

2 Avec un petit tournevis plat, soulevez la petite languette
plastique située en bas du porte-fusible jusqu'a ce qu'elle
se libere.

Sortez le porte-fusible et controlez 1'état des fusibles.

4 Le cas échéant, remplacez les fusibles grillés par des fusibles
T 4 A, 250 V CA (réf. 2110-1309).

5 Remettez le porte-fusible en place en appuyant jusqu'a ce que
vous entendiez un petit bruit.

6 Branchez le cordon d'alimentation.

Ne remplacez les fusibles que par des fusibles identiques ou de calibre
équivalent. Dans le doute, contactez le représentant local du service
clientéle Agilent avant d'installer les fusibles.
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— Porte-fusible

d'alimentation

Figure 37  Retrait du porte-fusible d'alimentation

Contrdle et remplacement du fusible du laser rouge Si le scanner
de puces a ADN démarre, mais que le laser rouge ne s'allume
pas, vous pouvez facilement controler et changer le fusible du
laser en vous placant a 'arriére de 'unité.

1 Débranchez le cordon d'alimentation.

2 Avec un petit tournevis plat, dévissez le petit couvercle
plastique rond jusqu'a ce qu'il se détache.
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Porte-fusible du
laser

Figure 38 Emplacement du porte-fusible du laser

3 Sortez le porte-fusible et contrdlez 1'état des fusibles.

4 Le cas échéant, remplacez le fusible par un fusible T 500 mA,
250 V CA (réf. 2110-0458).

5 Remettez le porte-fusible en place et vissez le couvercle.

Dépannage du bras de chargement automatique lorsqu'il reste
déplié dans le panier

1 Mettez le scanner hors tension.

2 Faites tourner le panier et repoussez le bras pour qu'il se

remette en place.

Si le probleme persiste, contactez le représentant local du
service clientéle Agilent pour obtenir des instructions.

Le fait de retirer le panier alors que le bras de chargement automatique
de diapositives est déplié endommage gravement le scanner de puces
a ADN.
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Utilisation d'HyperTerminal pour I'acquisition de données
de diagnostic

Le personnel d'entretien Agilent et les utilisateurs peuvent
configurer une session HyperTerminal pour recueillir des
données en vue du dépannage du scanner. Ces instructions
concernent les systéemes Windows XP. Pour savoir comment
capturer des données de diagnostic concernant un scanner sous
Windows Vista 32 bits, référez-vous aux notes de version du
logiciel Scan Control 8.4.

Configuration d'HyperTerminal

1 Mettez le scanner sous tension pour commencer
I'initialisation.
Ouvrez Scan Control pour activer les lasers.

Avant d'ouvrir HyperTerminal (étape 4), assurez-vous que le
scanner est sous tension depuis au moins 30 secondes.

4 Cliquez sur Démarrer > Tous les programmes > Accessoires
> Communications > HyperTerminal.

5 Dans la boite de dialogue Description de la connexion,
effectuez les opérations suivantes :

a Dans la zone de texte Nom, saisissez Scanner.

Connection Description

Enter a name and choose an icon for the connection:

M ame:
lScanner

[ Ok H Cancel ]

b Cliquez sur OK.
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Si vous mettez le scanner sous tension pendant I'exécution
d'HyperTerminal, I'initialisation du scanner échouera. Avant d'ouvrir
HyperTerminal, attendez que le scanner soit sous tension depuis au
moins 30 secondes.

6 Dans la boite de dialogue Connexion, effectuez les opérations
suivantes :

a Dans la liste déroulante Se connecter en utilisant,
sélectionnez le plus haut numéro COMX.

1l s'agit généralement de COMS3 ; le Gestionnaire de
périphériques Windows vous permet de vous en assurer.
Le port COM du scanner apparait sous le nom "Port série
USB (COMX)".

Connect To

Enter details for the phone number that you want to dial:

Country/region: | -0t

Area code: !

Fhone number: ! [

Cornectusing: | EXTERM |

[ Ok H Cancel ]

b Cliquez sur OK.

7 Dans la boite de dialogue Propriétés de COMX, effectuez les
opérations suivantes :

a Dans la liste Bits par seconde, sélectionnez 19200.

b Dans la liste Controle de flux, choisissez Aucun.
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COM3 Properties

Pt Setlings |

Bits per second: [1 5200 |

Data bits: [8 v

Stop bits: ! 1

Frow corvo: TSN |

FRestore Defaults

0K H Cancel ][ Apply ]

¢ Cliquez sur OK.
La fenétre Scanner — HyperTerminal s'ouvre.

8 Cliquez sur Fichier > Enregistrer pour enregistrer le fichier
sous le nom Scanner.ht. Ensuite, fermez la fenétre.

9 Un message vous demande si vous voulez vous déconnecter.
Cliquez sur Oui.

10 Créez une icone de raccourci vers Scanner.ht sur le Bureau,
comme suit :

a Cliquez sur Démarrer > Tous les programmes >
Accessoires > Communications.

b Dans le sous-menu HyperTerminal, cliquez avec le bouton
droit sur Scanner.ht.

Vous remarquerez que le sous-menu HyperTerminal a été
ajouté en bas du menu Communications. Ne faites pas de clic
droit sur l'icone du programme HyperTerminal, en haut du
menu.

¢ Dans le menu contextuel, cliquez sur Créer un raccourci.

d Cliquez sur le lien Raccourci vers Scanner.ht et faites-le
glisser jusque sur le Bureau.
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11 Ouvrez une session de capture de texte dans HyperTerminal,
comme suit :

a
b

c

Double-cliquez sur l'icone Scanner.ht du Bureau.
Cliquez sur Transfert > Capturer le texte.
Cliquez sur Parcourir.

Dans la boite de dialogue Sélectionner le fichier de
capture, placez-vous sur le lecteur Archive (E:).

Créez un dossier appelé Support.

Dans le dossier Support, créez un nouveau dossier, que
vous appellerez Fichiers de capture HyperTerminal.

Accédez au dossier Fichiers de capture HyperTerminal,
puis, dans la zone du nom de fichier, saisissez Capture
aammjj-n°, aammjj représentant la date du jour et n°, le
numéro de la session de capture dans la journée.

Cliquez sur Enregistrer.

Dans la boite de dialogue Capture de texte, cliquez sur
Démarrer.

Capture Text B 2%

Folder C:ADocuments and Settings\david_baker\My

File: |ml Capture Fies\Capture 060105-1. TXT Browse.
St | Cancel |

Les données HyperTerminal seront ajoutées a ce fichier jusqu'a
ce que l'on ferme HyperTerminal ou que I'on mette fin a la
session Capturer le texte dans le menu Transfert.

HyperTerminal se fermera a la fermeture de session.

Ouverture d'une session de capture HyperTerminal apres la
configuration initiale

Si le préchauffage des lasers est terminé, passez a 1'étape 3.

1 Mettez le scanner sous tension pour commencer
I'initialisation.

2 Ouvrez Scan Control pour faire préchauffer les lasers.
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3 Double-cliquez sur l'icone Scanner.ht du Bureau.

4 Dans le menu déroulant Transfert d'HyperTerminal, cliquez
sur Capturer le texte.

5 Dans la boite de dialogue Capturer le texte, effectuez les
opérations suivantes.

a Dans la zone Fichier, saisissez la date et le numéro de
session souhaités.

b Cliquez sur Démarrer.

Capture Text B 2%

Folder C:ADocuments and Settings\david_baker\My

File: |nd| Capture Files\Capture 0601IEH] 74T Browse.,
St | Cancel |

Vous pouvez également cliquer sur Parcourir pour ouvrir la
boite de dialogue Sélectionner le fichier de capture. Dans la
boite de dialogue Sélectionner le fichier de capture,
choisissez un nouveau dossier ou un nouveau nom de fichier
; sinon, les nouvelles données remplaceront le fichier de
capture initial. L'opération terminée, cliquez sur
Enregistrer.

Depannage logiciel

Agilent fournit un CD de restauration permettant de recharger
I'image de disque dur livrée avec le PC, notamment en cas de
panne informatique.

Avant d'utiliser ce CD, débranchez le cable USB connecté a
l'arriere du PC.

Si ce cable reste branché, I'opération risque de modifier les paramétres
Agilent par défaut attribués aux périphériques USB ; dans ce cas, le
logiciel ne reconnaitra plus le scanner.
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Messages d'erreur du scanner de puces a ADN

Cette section décrit la conduite a tenir face aux éventuels
messages d'erreur.

Sources de messages d'erreur

L'écran de I'ordinateur affiche les messages d'erreur du matériel
du scanner de puces a ADN, des logiciels Scan Control et
Feature Extraction, de Microsoft Windows et du PC. Pour
connaitre la source du message d'erreur, regardez la barre de
titre du message.

La barre de titre indique que ce message concerne
le matériel du panier.

Browsing carousel ﬂ

° Description: The chip carousel is not present, Please place the carousel in the scanner and try again,

Figure 39  Barre de titre d'un message d'erreur de Scan Control

Cette section présente les messages d'erreur du matériel du
scanner de puces a ADN et du logiciel Scan Control.

Si la barre de titre indique que le probléme concerne le PC ou
Windows, référez-vous aux informations de support de la
section "Support pour PC", page 74.

Emplacement des messages d'erreur du scanner

Les emplacements possibles de messages d'erreur du scanner
sont les suivants :

* Les messages relatifs aux erreurs survenant lors de l'initialisation
du scanner de puces a ADN s'affichent dans la zone Scanner
status (Etat du scanner) de la fenétre Scan Control (voir la section
"Etape 4 : numérisation des diapositives", page 32, au chapitre 2).

¢ Les erreurs se produisant avant le début de la numérisation
sont signalées dans des boites de message.
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¢ Certaines erreurs apparaissant pendant la numérisation
s'affichent dans la zone Status (Etat) de la boite de dialogue
Scan Progress (Avancement de la numérisation).

¢ Des messages d'erreur sont consignés dans le journal
Rapport de numérisation en série (Carousel Report Log)
pendant la numérisation en série (voir la section "Affichage
du journal Rapport de numérisation en série pendant
I'exécution", page 41, au chapitre 2).

Agilent recommande de consulter le journal Rapport au
moins apres la premiere numérisation, ainsi qu'a la fin de la
série de numérisations. Ce rapport est créé automatiquement
au terme d'une série de numérisations.

Utilisation des messages d'erreur en vue du dépannage

Le systeme de scanner de puces a ADN Agilent émet des
messages d'erreur pour vous aider a résoudre les problemes
éventuels. Bon nombre de messages d'erreur proposent
également une solution ; suivez les instructions fournies.

Le tableau suivant énumeére certains messages d'erreur non
accompagnés d'instructions. Les descriptions qu'il propose
contiennent des informations potentiellement utiles pour la
résolution du probléme.

Message d'erreur

Description/solution

Application Is Already Running (L'application
est déja en cours d'exécution)

Autofocus error: Did not detect two
reflective surfaces during home (Erreur
d'autofocus : le systéme ne détecte pas
deux surfaces réfléchissantes en position
de repos)

Il est impossible d'exécuter simultanément deux instances de Scan Control.

Procédez comme suit :

1 Vérifiez que la diapositive est correctement insérée dans le porte-diapositive.
Référez-vous a la section "Etape 2 : insertion des diapositives dans les
porte-diapositives", page 24 ou changez de porte-diapositive.

2 Vérifiez que la diapositive respecte les spécifications d'Agilent (voir la
section "Spécifications en matiére de diapositives", page 98).

3 Sile probléme persiste pour une méme diapositive, ¢'est peut-étre de cette
derniére que provient I'anomalie.

4 Sinécessaire, sélectionnez ou créez une région de balayage appropriée. Pour
certaines diapositives tierces comportant des bordures opaques ou
translucides, la région de balayage sélectionnée est peut-étre trop proche des
zones non transparentes du verre (voir la section "Création et modification de
régions de balayage avec Scan Region Editor", page 59).

5 Contactez le représentant local du service clientéle Agilent.
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Tableau 4 Messages d'erreur (suite)

Message d'erreur

Description/solution

Autofocus error. No PSD signal is
detected. Make sure there is a slide in the
chip holder. (Erreur d'autofocus. Aucun
signal PSD détecté. Assurez-vous que le
support de puce contient une diapositive.)

Autofocus was unable to retain focus as
it travelled to the scan start position
(Erreur d'autofocus : perte de la mise au
point lors du déplacement vers la position
de départ de la numérisation)

Cannot eject chip. There is already a chip
in the slot. (Impossible d'éjecter la puce.
L'emplacement en contient déja une.)

Cannot load chip, moving the arm may be
unsafe. (Impossible de charger la puce.
Mouvement du bras potentiellement
dangereux.)

Command timed out. (Dépassement du
délai imparti pour la commande)

Procédez comme suit :

1 Vérifiez que la diapositive est correctement insérée dans le porte-diapositive.
(voir la section "Etape 2 : insertion des diapositives dans les
porte-diapositives", page 24).

2 Vérifiez que la diapositive respecte les spécifications d'Agilent (voir la
section "Spécifications en matiére de diapositives", page 98).

3 Sile probléme persiste pour une méme diapositive, ¢'est peut-étre de cette
derniére que provient I'anomalie.

4 Pour certaines diapositives tierces comportant des bordures opaques ou
translucides, la région de balayage sélectionnée est peut-étre trop proche des
zones non transparentes du verre (voir la section "Création et modification de
régions de balayage avec Scan Region Editor", page 59).

5 Contactez le représentant local du service clientéle Agilent.

Procédez comme suit :

Vérifiez que la position de départ de la numérisation n'est pas occultée par un
code-barres.

2 Choisissez une région de balayage plus petite.

3 Sile probléme persiste pour une méme diapositive, c'est peut-étre de cette
derniére que provient I'anomalie.

4 Contactez le représentant local du service clientéle Agilent.

Procédez comme suit :

1 Ouvrez le capot du scanner.
2 Retirez le porte-diapositive de I'emplacement de départ.

Procédez comme suit :

1 Ouvrez le capot du scanner.

2 Sile bras de chargement automatique est partiellement déplié et entre dans
le compartiment du panier, repoussez-le doucement dans le scanner jusqu'a
la butée.

3 Sile probléme persiste, contactez le représentant local du service clientéle
Agilent.

Procédez comme suit :

1 Vérifiez que le cable USB reliant le scanner de puces a ADN au PC est
branché.

2 Mettez le scanner de puces a ADN hors tension, puis de nouveau sous
tension.

3 Rouvrez Scan Control.

4 Sile probléme persiste, contactez le représentant local du service clientéle
Agilent.
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Tableau 4 Messages d'erreur (suite)

Maintenance et dépannage du systéeme

5

Message d'erreur

Description/solution

Connection manager reports that there
are no instruments. (Le gestionnaire de
connexions signale |I'absence
d'appareils.)

Error ejecting chip. The chip was ejected
into the home slot. (Erreur d'éjection de la
puce. La puce a été éjectée dans
I'emplacement de départ.)

Failed to communicate with connection
manager. (Echec de la communication
avec le gestionnaire de connexions)

Lasers never became ready. (Les lasers
ne sont toujours pas préts.)

Cette erreur peut notamment résulter des situations suivantes :

Le scanner de puces a ADN est hors tension, ou I'autotest et I'initialisation ne
sont pas terminés. Cliquez sur OK pour acquitter le message de Scan Control,
attendez quelques minutes et réessayez.

Le scanner de puces a ADN n'est pas connecté au PC. Vérifiez que le cable
USB est branché au scanner de puces a ADN et au PC. Si ce n'est pas le cas,
rebranchez le cable et réinitialisez le PC ; si nécessaire, mettez ensuite le
scanner de puces a ADN hors tension, puis de nouveau sous tension.

Les propriétés de réseau TCP/IP du scanner ont été modifiées. Dans les
propriétés de connexion au réseau local du scanner, vérifiez que I'adresse IP
est réglée sur 10.0.0.1 et le masque de sous-réseau sur 255.255.255.0.

Le pare-feu Windows XP empéche la communication. Désactivez-le.

Si vous avez réinitialisé le PC, vous devrez peut-étre mettre le scanner de
puces a ADN hors tension, puis de nouveau sous tension apres le
redémarrage de Windows.

Procédez comme suit :

1
2
3

[L 0]

Mettez le scanner hors tension.

Ouvrez le capot du scanner.

Tournez manuellement le panier jusqu'a ce que vous puissiez accéder a
I'emplacement de départ sans que le bras de chargement automatique vous
géne.

Retirez |a diapositive de I'emplacement de départ.

Repoussez délicatement le bras de chargement automatique dans le scanner
jusqu'a la butée.

Si le probléme persiste, contactez le représentant local du service clientéle
Agilent.

Procédez comme suit :

1
2

3

Réinitialisez le PC.

Mettez le scanner de puces a ADN hors tension, puis de nouveau sous
tension.

Laissez passer quelques minutes, puis ouvrez Scan Control.

Procédez comme suit :

1
2

3

Vérifiez que le nombre visible dans le sélecteur de tension, a I'arriére du
scanner, correspond a |'alimentation fournie.

Si vous avez réinitialisé le PC, vous devrez peut-étre mettre le scanner de
puces a ADN hors tension, puis de nouveau sous tension aprés le
redémarrage de Windows.

Si le probléme persiste, contactez le représentant local du service clientéle
Agilent.
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Tableau 4 Messages d'erreur (suite)

Message d'erreur

Description/solution

Missing or corrupt ChipRegions.ini file.
(Fichier ChipRegions.ini manquant ou
corrompu)

Not enough disk space to create file.
(Espace disque insuffisant pour la
création du fichier)

PMT calibration may be unstable. Using
last known PMT setting. (Possibilité
d'instabilité de I'étalonnage du PMT.
Utilisation du dernier réglage connu du
PMT.)

PMT calibration lost! Using factory
default settings. (Perte d'étalonnage du
PMT. Utilisation des réglages d'usine.)

Slide skipped because it is outside the
allowable thickness range or the selected
scan region contains an obstruction to
the initial focus positions. (Diapositive
ignorée parce qu'elle ne respecte pas la
plage d'épaisseurs admissibles ou que la
région de balayage sélectionnée
comporte une obstruction au niveau des
positions de mise au point initiale)

The autoloader loading arm is in an
unknown location. It is unclear if it is safe
to move the carousel. (Emplacement du
bras de chargement automatique
inconnu. Mouvements du panier
potentiellement dangereux.)

Procédez comme suit :

1 Sivous disposez d'une copie de sauvegarde du fichier ChipRegions.ini,
copiez-la dans le répertoire C:\Program Files\Agilent\Microarray. Une
copie de sauvegarde de ChipRegions.ini évite la perte et la recréation des
régions de balayage personnalisées.

2 Sivous n'avez pas de copie de sauvegarde, recherchez le fichier
ChipRegions.bak dans le dossier et changez son nom en ChipRegions.ini.

3 Siaucun de ces fichiers n'existe, réinstallez Scan Control.

4 Contactez le représentant local du service clientéle Agilent.

Le disque dur ne comporte pas assez d'espace libre pour la création d'un fichier
destiné au stockage des données de numérisation. Procédez de I'une des
manieres suivantes :

+ Dans le menu principal de Scan Control, réglez le chemin de sortie sur un
autre répertoire d'un autre disque dur.

» Supprimez ou déplacez des fichiers du disque dur actuel (voir la section
"Etape 5 : transfert des fichiers et archivage des données", page 42).

Vous pouvez réinitialiser cet avertissement au moyen de |'outil Reset
Calibration Warnings (Réinitialiser les avertissements d'étalonnage ; voir la
section "QOutils supplémentaires", page 65). Si le probléme persiste ou survient
de nouveau, contactez le représentant local du service clientéle Agilent.

Vous pouvez réinitialiser cet avertissement au moyen de I'outil Reset
Calibration Warnings (Réinitialiser les avertissements d'étalonnage ; voir la
section "Outils supplémentaires”, page 65). Si le probléme persiste ou survient
de nouveau, contactez le représentant local du service clientéle Agilent.

Procédez comme suit :

1 Surladiapositive ignorée, recherchez un code-barres, un résidu d'hybridation
ou toute autre obstruction opaque masquant la position de mise au point
initiale. La position de mise au point initiale se trouve dans la ligne supérieure
de la région de balayage, 1 a 2 mm a gauche de cette derniére.

2 Mesurez I'épaisseur du verre et assurez-vous qu'elle respecte les
spécifications de la section "Spécifications en matiére de diapositives",
page 98.

Procédez comme suit :

1 Ouvrez le capot du scanner.

2 Sile bras de chargement automatique est partiellement déplié et entre dans
le compartiment du panier, repoussez-le doucement dans le scanner jusqu'a
la butée.

3 Fermez et rouvrez le logiciel Scan Control.

4 Sile probléme persiste, contactez le représentant local du service clientéle
Agilent.
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Tableau 4 Messages d'erreur (suite)

Maintenance et dépannage du systéeme L

Message d'erreur

Description/solution

The chip carousel is not present. Please
place the carousel in the scanner and try
again. (Panier de puces absent. Placez le
panier dans le scanner et réessayez.)

The carousel may be misaligned. Please
remove the carousel, make sure that its
opening is aligned with home position
and reinsert the carousel. (Possibilité
d'alignement incorrect du panier. Retirez
le panier, vérifiez que I'ouverture est
alignée sur la position de départ et
remettez le panier en place.)

The slide failed to eject. Pressing OK will
re-initialize the instrument. (Echec de
I"éjection de la diapositive. Appuyez sur
OK pour réinitialiser I'appareil.)

The software has detected a serious
sensor error that may have existed prior
to the installation of this version of
software. (Le logiciel a détecté une grave
erreur de capteur, peut-étre antérieure a
I'installation de cette version logicielle.)

Unable to lock instrument specified by
connection manager. (Impossible de
verrouiller I'appareil désigné par le
gestionnaire de connexions)

You must select a region to scan first.
(Vous devez d'abord sélectionner une
région a balayer.)

Placez le panier dans le scanner de puces a ADN et relancez la série de
numeérisations (voir la section "Etape 2 : insertion des diapositives dans les
porte-diapositives", page 24).

Référez-vous a la section "Etape 2 : insertion des diapositives dans les
porte-diapositives", page 24.

Appuyez sur OK. Le scanner de puces a ADN se réinitialise. Si le probléme
persiste, procédez comme suit :

1
2

Ouvrez le capot du scanner.

Si le bras de chargement automatique est partiellement déplié et entre dans
le compartiment du panier, repoussez-le doucement dans le scanner jusqu'a
la butée. Si le bras résiste, ne forcez pas.

Fermez et rouvrez le logiciel Scan Control.

Si le probléme persiste, contactez le représentant local du service clientéle
Agilent.

Contactez le représentant local du service clientéle Agilent.

Procédez comme suit :

1
2

3

Réinitialisez le PC.

Mettez le scanner de puces a ADN hors tension, puis de nouveau sous
tension.

Rouvrez Scan Control.

Pour définir une région de balayage ne figurant pas dans le profil sélectionné
dans le tableau de numérisation, procédez comme suit :

1
2
3

Sélectionnez le ou les emplacements concernés par la région a définir.
Cliquez sur la fleche vers le bas, a droite des cellules sélectionnées.

Dans la liste Scan Region (Région de balayage), sélectionnez une région (voir
la section "Modification de paramétres pris isolément dans le tableau de
numérisation”, page 46).

Lancez la numérisation ou la série de numérisations.
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Tableau 4 Messages d'erreur (suite)

Message d'erreur Description/solution

You must select at least one dye channel. 1 Sélectionnez le ou les emplacements concernés par le changement de voie
(Vous devez sélectionner au moins une de colorant.
voie de colorant.) 2 Cliquez sur la fleche vers le bas, a droite des cellules sélectionnées.
3 Sélectionnez un paramétre de voie de colorant dans la liste (voir la section
"Channels (Voies de colorant)”, page 49).

You must close the door first. (Vous devez  L'initialisation du scanner de puces a ADN, ainsi que la numeérisation, exigent

d'abord fermer le capot.) que le capot soit fermé. Fermez le capot.

Warning: The laser power does not fall Laissez s'écouler le temps de préchauffage nécessaire (environ 30 minutes) et
within expected thresholds. Please attendez que le message Scanner ready (Scanner prét) s'affiche dans la zone
contact an Agilent representative. d'état du scanner de Scan Control. Vous pouvez réinitialiser cet avertissement
(Avertissement : la puissance laser ne au moyen de |'outil Reset Calibration Warnings (Réinitialiser les avertissements
respecte pas les seuils attendus. d'étalonnage ; voir la section "Outils supplémentaires”, page 65). Si le probléme
Contactez un représentant d'Agilent.) persiste ou survient de nouveau, contactez le représentant local du service

clientéle Agilent.

Scan Control reconfigure le fichier TIFF pour compenser la baisse de puissance
des lasers.

Messages d'erreur ne figurant pas dans le tableau

Ce tableau ne répertorie pas tous les messages d'erreur
possibles. Si un message d'erreur n'y figurant pas apparait et
que vous ne parvenez pas a résoudre le probléme, procédez
comme suit :

1 Relevez le message d'erreur.

2 Rouvrez Scan Control.

3 Sile probleme persiste, procédez comme suit :
a Réinitialisez le PC.

b Mettez le scanner de puces a ADN hors tension, puis de
nouveau sous tension.

¢ Rouvrez Scan Control.

4 Sivous ne parvenez toujours pas a résoudre le probléme,
contactez le représentant local du service clientele Agilent.

94 Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Spécifications du scanner de
puces a ADN

Spécifications en matiére de
diapositives

Informations
surla
réglementation
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Agilent G2565CA Systéme de scanner de puces a ADN
(Logiciel Scan Control 8.4)
Guide d'utilisation

6
Reféerences

Spécifications du scanner de puces a ADN 96
Spécifications en matiére de diapositives 98
Informations sur la réglementation 102
Contrdle de la tension d'entrée 105

Ce chapitre comprend des spécifications, des informations sur
la réglementation et des instructions de contrdle de la tension
en cas de déplacement de l'appareil.

Cette section décrit les spécifications du scanner de puces a
ADN. Pour connaitre les spécifications du PC, consultez le guide
d'utilisation fourni avec ce dernier.

Cette section présente les spécifications des lames de verre et
des codes-barres que le scanner est concu pour accepter.

Cette section décrit la conformité du scanner a la
réglementation en matiére de bruit acoustique, de recyclage, de
mise au rebut, d'interférences électromagnétiques et de
sécurité.

Cette section décrit la marche a suivre pour s'assurer que la
tension d'entrée est correcte, aprés un déplacement.

Agilent Technologies
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Spécifications du scanner de puces a ADN

96

Dimensions
approximatives

Poids

Alimentation

Fusibles

Plage de

températures

Humidite

Altitude

Utilisation

Informations
sur les lasers

Les spécifications de fonctionnement du scanner de puces a
ADN sont les suivantes :

Hauteur : 97 cm (38") ; capot fermé, 55 cm (21,5")
Largeur : 91 cm (36")
Profondeur : 71 cm (28")

Ces dimensions correspondent a la hauteur et a la largeur
maximales, capots ouverts, avec 80 mm (3") d'espace en
profondeur pour une ventilation adéquate.

99 kg (218 1bs)

100, 120,220 0u 240 VCA a4 A

50/60 Hz

Deux fusibles d'alimentation : T 4 A, 250 V CA (réf. 2110-1309)
Un fusible de laser : T 500 mA, 250 V CA (réf. 2110-0458)

En fonctionnement : 15 4 30 °C

Stockage : -20 a +50 °C

En fonctionnement : 15 2 95 % HR 4 30 °C

Risque de sensibilité a I'numidité au point de saturation.
Respectez les consignes données au chapitre 5.

Maximale en fonctionnement : 2 300 m (7 500 pieds)
Maximale de stockage : 4 600 m (15 000 pieds)
Locaux fermés

Longueurs d'onde d'excitation :
* Laser YAG a doublage de fréquence : 532 nm
¢ Laser a hélium-néon (HeNe) : 633 nm

Puissance : 20 mW a 532 nm et 23 mW a 633 nm, avec controle
13 mW pour les deux
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Region de balayage
maximale

Région imprimée
des puces
(recommandation)

Colorants pris
en charge

Résolution
(taille de pixel)

Erreur de positionnement
des pixels

Uniformite

Durée de
numérisation

Plage dynamique

Références 6

Agilent G2565CA : 71 x 21,6 mm

Plus étroite que la région de balayage de 1 mm sur la droite, de
2 mm sur la gauche et de 0,6 mm en haut et en bas. Pour les
diapositives tierces, soustraire la tolérance d'impression des
puces des dimensions obtenues.

Cyanine 3 (Cy 3) et cyanine 5 (Cy 5), colorants similaires,
colorants Alexa 647, 555 et 660

2,3, 5 ou 10 microns

< 1 pixel a la résolution de 5 microns

Non-uniformité globale : 5 % CV. Non-uniformité locale moyenne
type : 1 % pour des motifs de 100 um.

Tableau 5 Durée de numérisation, en modes simple balayage et double
balayage, pour une région de numérisation haute définition
Agilent de 61 x 21,6 mm

Durée de
numeérisation
(min.)

Résolution

Un seul balayage, 2 microns 20
Un seul balayage, 3 microns 15
Un seul balayage, 5 microns 8
Un seul balayage, 10 microns 8
Double balayage, 2 microns 40
Double balayage, 3 microns 30

Double balayage, 5 microns 16

> 104 pour un seul balayage en mode 16 bits
> 10° pour un seul balayage en mode 20 bits

Plage dynamique étendue > 108 pour un double balayage
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Speécifications en matiére de diapositives

Dimensions de la région numérisée

La région de balayage est représentée a la Figure 40. Toutes les
dimensions sont exprimées en millimeétres. Le point de
référence est l'angle inférieur du coté droit de la lame.
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Figure 40  Région de balayage du scanner Agilent G2565CA

Specifications du verre

Le scanner de puces a ADN utilise des porte-diapositives
pour placer les puces dans le panier et les en retirer. Les
porte-diapositives sont con¢us pour accepter des lames de verre

de 25,4 x 76,2 mm (1" x 3").

Les spécifications détaillées du verre sont les suivantes :
e Largeur : 25,4 mm (1") -0,45 mm ou +0,7 mm

¢ Longueur : 76,2 mm (3"), +0,25 mm ou -1,4 mm

e Epaisseur: 1 mm (0,1 mm)

* Lames non réfléchissantes

¢ Haute qualité, faible fluorescence intrinséque

¢ Indice de réfraction compris entre 1,510 et 1,515
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Speécifications de codes-barres et d'étiquettes de code-barres

Spécifications de codes-barres pour les diapositives Agilent

Le scanner G2565CA lit les codes-barres placés sur la face
active de la diapositive.

Pour des raisons de compatibilité avec les scanners G2565AA,
les puces a ADN Agilent portent toujours des codes-barres sur
leurs deux faces. L'étiquette "Agilent" permet de repérer la face
active ; la valeur numérique indique la face inactive.

Double-barcoded slide example

=
=l
SIDE1 £ = Inactive Glass Surface
S
|
=
i . .
= = Active Active
SIDE 2 §= Microarray Microarray
2= Surface Surface
u
=

Figure 41  Orientation des codes-barres Agilent et des surfaces des
puces a ADN

Spécifications de codes-barres pour les diapositives tierces

¢ L'épaisseur maximale de 1'étiquette de code-barres est de
0,2 mm. Assurez-vous de l'absence de bulles dans I'étiquette.
Ne superposez pas les étiquettes et ne remplacez pas les
étiquettes qui se décollent.

¢ Ne placez pas d'étiquettes de code-barres sur les diapositives
dont la région de balayage dépasse 61 mm. Vous devez saisir
manuellement l'identificateur ou le code-barres de ces
diapositives.
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100

¢ Sila diapositive comporte un code-barres, la distance entre

le bord de la région de balayage de la puce et celui de
I'étiquette de code-barres doit €tre d'au moins 4 mm.
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Figure 42 Emplacement du code-barres sur une diapositive tierce

e L'étiquette de code-barres doit faire environ 6 mm de large ;

la largeur recommandée est définie pour une région de
numérisation de 61 mm. Il est possible d'utiliser des
étiquettes de code-barres plus longues ou plus larges ; il
suffit de réduire la région de numérisation en conséquence.

Les étiquettes de code-barres ne doivent pas empiéter sur
les taquets du porte-diapositive.

L'inclinaison maximale de I'étiquette de code-barres par
rapport a la diapositive est de +3°.

Le code-barres doit remplir les conditions suivantes :

¢ Le blanc (région comprise entre le bord de 1'étiquette et le

début ou la fin du code-barres) minimal doit étre 10 fois
supérieur au module de base, de chaque c6té du code-barres.

Les lignes du code-barres doivent étre paralleles au grand
coté de la diapositive, avec une tolérance d'inclinaison
de £3°.

¢ Agilent accepte les formats de code-barres suivants :

Code 128 : les code-barres tiers a 12 chiffres ne doivent
pas commencer par 2

CODABAR : 8 chiffres maximum ; épaisseur de ligne
minimale = 6 mils
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Code 39 : 8 chiffres maximum ; épaisseur de ligne
minimale = 6 mils

Code 93 : 8 chiffres maximum ; épaisseur de ligne
minimale = 6 mils

¢ La hauteur minimale du code-barres doit étre la suivante :
Code 128 : 15 % de la longueur du code-barres

Code 39, Code 93, CODABAR : 5 mm ou 15 % de la
longueur du code-barres, selon la valeur la plus élevée
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Informations sur la réeglementation

Francais

Deutsch

Pour en savoir plus sur le recyclage
et la mise au rebut, contactez

Agilent Technologies.

Emissions

Immunité

Cette section fournit des informations concernant la
réglementation applicable au scanner de puces a ADN.

Utilisation a des fins de recherche uniquement

Le scanner de puces a ADN Agilent G2565CA est RESERVE A
LA RECHERCHE.

Informations sur le bruit acoustique
Déclaration du fabricant :

Cette déclaration vise a garantir la conformité aux exigences
de la directive allemande du 18 janvier 1991, relative aux
émissions sonores. Niveau de pression acoustique pour
l'utilisateur < 70 dB(A) en fonctionnement normal, selon la
norme EN 27779 (essai type).

Die folgende Information wird in Ubereinstimmung mit den
Anforderungen der Maschinenlarminformationsverordnung
vom 18. Januar 1991 erteilt. Schalldruckpegel am Arbeisplatz
bei normalem Betrieb, Lp < 70 dB(A), nach EN 27779

(Typprifung).
Recyclage et mise au rebut

Ce produit est con¢u dans une optique de recyclage a la fin de sa
vie utile. Veuillez le mettre au rebut conformément a la
réglementation locale.

Interférences électromagnétiques
Ce scanner est réservé a une utilisation avec des cables blindés.

Cet appareil respecte les niveaux d'émissions du matériel de
classe A, selon les exigences de la norme CEI 61326-1. Il n'est
pas destiné a une utilisation en zone résidentielle.

Cet appareil respecte les niveaux d'immunité exigés par la
norme CEI 61326-1 pour les environnements non industriels
non controlés. Pour connaitre les niveaux de conformité précis,
référez-vous au Certificat de conformité joint.

102  Guide d'utilisation du systéme de scanner de puces a ADN Agilent G2565CA (Logiciel Scan Control 8.4)



Références 6

Canada This ISM (Industrial-Scientific-Medical) device complies with
Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du Canada.
Informations relatives a la sécurité
Ce scanner est conforme aux normes de sécurité suivantes :

CAN/CSA C22.2 Safety Requirements for Electrical

n°®1010.1-92 Equipment for Measurement, Control, and
Laboratory Use, Part 1: General Requirements
(Conditions de sécurité des appareils électriques
de mesure, de contrdle et de laboratoire, Partie 1:
Exigences générales ; amendement 1 compris)

CAN/CSA C22.2 Amendment 2 to CAN/CSA-C22.2 No.1010.1-92,
n°1010.1B-97 Safety Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use,
Part 1: General Requirements (Amendement 2 a
la norme CAN/CSA C22.2 n° 1010.1-92,
Conditions de sécurité des appareils électriques
de mesure, de contrdle et de laboratoire,
Partie 1: Exigences générales)

Norme UL 3101.1 Electrical Equipment for Laboratory Use:
Part 1: General Requirements (Appareils électriques
de laboratoire ; Partie 1 : Exigences générales)

Norme UL 3111-1 Equipment for Measurement Use;
Part I: General Requirements (Instruments de
mesure ; Partie 1 : Exigences générales)

ISA S82.01-1994 Safety Standards for Electrical and Electronic Test,
Measuring, Controlling, and Related Equipment —
General Requirements (Normes de sécurité des
appareils électriques et électroniques d'essai, de
mesure ou de commande et de I'équipement
associé — Exigences générales)

CEI 61010-1 Safety Requirements for Electrical
Equipment for Measurement, Control, and
Laboratory Use, Part 1: General Requirements
(Conditions de sécurité des appareils électriques
de mesure, de contrdle et de laboratoire,
Partie 1: Exigences générales)

CEI 825-1 Safety of laser products Part 1: Equipment
classification, requirements and user's guide
(Sécurité des appareils a laser, Partie 1:
classification des matériels, prescriptions et
guide de I'utilisateur)

EN 60825-1
(dont Amendement 1:1992 et Amendement 2:1995)
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Spécifications de codes-barres et d'étiquettes de code-barres

e Degré de pollution : 2

e (Catégorie d'installation : II

¢ Matériel de classe 1 ; systeme de mise a la terre requis
e Appareil a laser de classe 1

¢ Produit homologué UL/CSA
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Controle de la tension d'entrée

Verification de la tension d'entrée

Avant la premiere mise sous tension du scanner de puces a ADN
ou apres le déplacement de l'appareil, assurez-vous que la
tension d'entrée est réglée correctement a l'arriere de 'appareil.
La tension d'entrée peut étre réglée sur les quatre valeurs
suivantes :

* 100V CA
e 120VCA
e 220V CA
e 240V CA
1 Placez-vous a l'arriére du scanner de puces a ADN.

2 Controlez le réglage de tension d'entrée (vous le voyez par
la petite fenétre).

\r’ﬁ Eﬁ\
. ]s Fenétre de
lecture du
Q/ 1l réglage de

tension d'entrée
o
< 0 u
N\ Ve

Figure 43  Fenétre de lecture du réglage de tension d'entrée

3 Sile réglage de tension d'entrée correspond a la tension
secteur, vous pouvez mettre le scanner de puces a ADN
sous tension.

Sinon, changez le réglage de tension.
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Modification du réglage de tension

1 Débranchez le cordon d'alimentation.

Débranchez toujours le cordon d'alimentation avant de régler la
tension d'entrée.

2 Avec un petit tournevis plat, soulevez la petite languette
plastique située en bas du porte-fusible jusqu'a ce qu'elle se
libere.

Porte-fusible

Figure 44  Retrait du porte-fusible d'alimentation

3 Sortez le porte-fusible de son logement.
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4 Retirez le sélecteur de tension a l'aide d'une pince
a bec effilé.

Sélecteur de tension

2
\ >/ Porte-fusible

Figure 45 Retrait du sélecteur de tension depuis le porte-fusible

b Insérez le sélecteur de tension en le placant de maniére que
le nombre visible corresponde a la tension secteur.

6 Remettez le porte-fusible en place en appuyant jusqu'a ce que
vous entendiez un petit bruit.

7 Branchez le cordon d'alimentation.
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Modification du réglage de tension
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